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the accuracy of Benchmark’s performance predictions before you depend on them.
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Introduction

In the early 1940’s, the Boeing Aircraft Company had just finished building the B-17 bomber and needed to supply a
flight manual that would show the performance and range of the airplane at various weights.  Because there was no way
to determine the efficiency of the propellers, Boeing’s test pilots took the plane to 20,000’, shut the engines off and
ran the plane through a time-honored glider-test procedure to determine the characteristics of the plane.  The absurdity
of this did not escape notice of Boeing’s management, who asked the Flight and Aerodynamics Department to see if
they could develop a better method.

A small team of engineers, under the direction of Edmund T. Allen, developed a method of performance testing and
analysis that was used for B-17, B-29 and other aircraft during WWII.  This method was described in the January 1943
Journal of Aeronautical Sciences.  The method is precise, and it has stood the test of time and technological
improvements.  This is the method that is used by virtually all of the major aircraft manufacturers to obtain the
performance data on their aircraft.  

The flight testing required by this method is astonishingly simple and can easily be done by anyone, but the analysis
of the flight data is an impossibly complex series of calculations.  While most of the calculations are easily done by a
computer, there have been three stumbling blocks—propeller efficiency, engine power and fuel flow—that have
prevented computers from being used to automate this process.  

We’ve overcome those problems and the result is Benchmark, the first program on any computer to automate the
process of flight test performance analysis.  In a matter of a few hours, you can duplicate the performance flight test
data analysis and charting that heretofore would have taken a trained engineer months of painstaking work.
Furthermore, Benchmark requires no engineering training to use—in fact, it makes this previously mind-numbing
process into an interesting exercise that’s actually fun.  

By using Benchmark, you will be able to generate flight manual charts for your specific aircraft, not a factory-average
machine, and you should also gain a deeper understanding into the efficient operation of the aircraft.  

Benchmark includes:

• Complete database management with easily mastered data entry and editing.
• Instrument data correction by curve-fitting a polynomial to the data of actual vs indicated.  
• Pitot-static system correction by curve-fitting a polynomial to the data of Vias vs Vcas.  
• Atmospheric calculations.  
• Calculation of propeller efficiency in precise agreement with the Boeing General Propeller Chart.  
• Calculation of engine power output at any altitude or temperature.  
• Limiting manifold pressure for continuous operation.
• Induction system ram recovery.
• Analysis of drag polar flight test data and calculation of Cdo and Oswald E.
• Calculation of engine fuel consumption for full rich, best power and best economy mixture

settings.  
• Calculation of aircraft performance at any altitude, temperature or weight, or power setting.
• Production of camera-ready charts for aircraft flight manuals, including miles-per-gallon charts.
• High-resolution Encapsulated PostScript graphics output for editing with graphics programs such

as PowerDraw and Adobe Illustrator, and inclusion with electronic publishing systems such as
PageMaker, Microsoft Word, and others.

As it now stands, Benchmark is not the program we would like it to be.  There are many additional features we plan to
add to the program.  The most immediate things to add are printing for all of the dialog boxes that have a print button.
We also have some work to do on smoothing out some minor things.  

We plan to add engine power charts in a variety of forms.  We’d like to add sawtooth climb tests, but we are presently
unsure about how to integrate the results into Benchmark’s calculations of performance.  We’d like to add takeoff
charts, but we don’t know how to do that yet.  There are a number of range vs altitude charts that we’d like to do.  The
propeller efficiency charts need some controls in the dialog box.  
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In developing Benchmark, we’ve concentrated first on getting the job done and have left the nuances of interface design
for a later date.  You will note that when you open a Benchmark document, a window comes up with the name of the
document, but other than that, it doesn’t do diddly.  So if you feel offended by not seeing a click-and-drag window with
an elegant Macintosh interface, please hold your fire and give us time to get all of the features into the program before
we tackle that part of it.  

There are a few things about the way Benchmark works that we should explain.  

• Benchmark is a highly modal program.  This makes the management of extremely complicated
data structures possible and allows for a tightly controlled sequence of operations.  This is
sometimes frustrating, but allows us to achieve trouble-free operation without going  mad.  

• The data entry of numbers is tightly controlled.  This keeps you out of trouble, but it’s sometimes
irritating to have Benchmark watching your every keystroke.  Every entry of a number has a high
and a low limit, and in a few cases those limits are rather close together.  In those situations, you
may find that you must change a number a single character at a time.  

• The behavior of the text insertion cursor during the rejection of a number is, well, kludgy.  We’ve
tried a number of methods to get the selection range of a dialog boxes text edit records and so far
nothing has worked.  There are no built-in routines in the Macintosh toolbox that handle this
situation.  

• Because of space limitations in the dialog boxes, we’ve implemented something we call “toggle
buttons” instead of using several radio buttons.  A toggle button has a distinctive border, and it
changes its name every time you click on it.  We rather like the way they look and feel, and hope
you agree.  

Benchmark is the result of years of work.  I began work on it in 1986, and I’ve spent countless hours on the program.
The size of the program is astonishing, when you print out the program it weighs three pounds and stretches for the
length of a football field.  We did not copy-protect Benchmark because I hate copy-protection as much as you do and
we wanted Benchmark to be convenient to use.  Please don’t duplicate Benchmark for others to use.  They should
purchase their own copies of Benchmark, just as you did.  

I’m always open for any suggestion you might have for adding things to Benchmark.  Please, please, please submit
these ideas in writing.  Think your idea out carefully.  Explain what you want to accomplish and then give me some
idea of how you think it might be handled from the standpoint of user-interface or dialog box design.  If there’s some
math involved, please let me have that as well.  

I should tell you that there are absolutely no undocumented features to Benchmark, and we have made every effort to
document the program fully.  If we’ve failed, please tell us what parts confuse you, but please do not call for “technical
support” as an alternative to reading the manual.  

Special thanks to Fen and Dorothy Taylor who are both aeronautical engineers specializing in the performance testing
field and from whom we got this technology.  I’m also deeply indebted to Jim Petty, who has a remarkable ability to
turn a problem into an equation.  Many thanks to Hoyle Fulbright, Bill and Todd Stanley for their assistance on
programming problems.  Finally, thanks to Borland International for Turbo Pascal for the Macintosh—a remarkable
product—and for their Turbo Pascal Tutor, the best introductory book I’ve read on programming and which got me
started.  

I hope you enjoy using Benchmark and that it will increase your understanding of the efficient operation of your
aircraft, but please don’t let it loll you into taking chances with low fuel situations.  Always remember that the
calculations produced by Benchmark are not reality.  Your airplane is reality, and it is essential that you confirm the
accuracy of Benchmark’s performance predictions before you depend on them.  Take care of yourself.  

Alfred P. Scott
President
Sequoia Aircraft Corporation
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Chapter 1
Curves, Computers and Curve-Fitting

Data and Curves
Engineers, scientists and statisticians have faced an age-old problem with curves as a method of predicting the behavior
of phenomenon.  This might be the relationship between the population of red-headed people and the consumption of
pomegranates, or the frequency of sunspot behavior to changes in the weather.  

You can spend a lifetime gathering data on red-heads and pomegranates and looking in vain for a statistical relationship,
but sunspots are quite a different matter.  Sunspot activity increases dramatically on 11- and 22-year cycles and
scientists have noticed that there is a corresponding drop in rainfall during these periods—the Oklahoma dustbowl of
the 30’s coincided with one of these peaks of sunspot activity.  

But the problem is that daily sunspot activity and rainfall are highly irregular.  And to complicate matters, rainfall is
seasonal, and when we talk about 11- and 22-year cycles of sunspot activity we’re actually rounding things off a
bit—sunspots do their thing without any regard to where the planets are in their paths around the sun.  

If you study such things, sometimes you can find a relationship by plotting the data as a series of points on a chart and
just looking at it—“Look at this, Miss Mergatroid, red-heads do eat more pomegranates in August and September!”
Once you have found a neat relationship of data, the next thing you want to be able to do is to predict this behavior.  

Polynomial Equations
When the relationship is a simple curved line, a method that is frequently used with computers is fitting a polynomial
equation to the curve.  A polynomial is simply an equation that looks like this:

Y = A + BX + CX2 + DX3 + EX4

In this example, the letters A, B, C, D and E are the coefficients.  These are simply numbers that are calculated by an
excruciatingly convoluted and repetitive process to make the equation fit the curve, as best can be done.  You don’t
need to worry about these numbers, Benchmark will calculate them for you.  

What you do need to understand is the order of the polynomial.  Note that as you move to the right of the equation,
each expression of X has a larger exponent.  Polynomials can be of any length that you want, you just keep adding
more expressions of X with each one raised to a higher power—continue this higher power business long enough and
you will eventually see God.  In the example above, the largest power that X is raised to is 4, and for this reason, the
“order” of the polynomial is 4.  

Although polynomials may be of any order, in Benchmark they are limited to the range of 0 to 10, which as you will
see is more than enough for our purposes.  Because you will be selecting the order of the polynomial to use, you need
to understand the kinds of curves that these equations produce.  It’s quite simple.  

Polynomial Order of 0
Because the order of X is zero, the value of X has no influence on the value of Y, and X disappears from the equation
completely.  A polynomial with the order of zero is the ultimate over-simplification and rarely is useful.  Here’s an
example:

Y = 3

There’s no X in this equation at all, so Y always equals 3 regardless of the value of X.  This polynomial is simply an
average of all of the Y-values in the data.  The “curve” that this equation will generate is a simple horizontal
line—almost always useless for our purposes.  



Benchmark

Polynomial Order of 1
A polynomial with the order of 1 looks like this:

Y = 3 + 5X

This is straight line.  A simple linear relationship.  If the data falls on a straight line, then you should select this order.  

Polynomial Order of 2
A polynomial with the order of 2 looks like this:

Y = 3 + 5X + 4X2

Now this one is a curve!  

It’s also the choice you’ll most often be making in Benchmark.  You probably have heard that when you drop an
object in a vacuum, the speed increases with the square of the time (32 feet per second squared) or that the drag of an
airplane goes up with the square of the speed, or Einstein’s famous E = MC2.  Whenever you are talking about speeds,
you are almost always talking about things that increase with the square of the speeds.  That’s just the nature of
physics—and to answer the question of the kid on the front row, there’s no why to it.  

So whenever you are dealing with a polynomial that is intended to represent something that is a function of speed, you
should always give a heavy preference to the second-order polynomial, even if the disparity with the data is greater than
with an higher-order polynomial.  The disparity is most likely to be in your data.  All of the curves relating to the
engine—friction horsepower, maximum horsepower, maximum manifold pressure, and fuel flow—fall into this
category, and you should have a good idea about the kind of curve that should be generated.  

High-Order Polynomials
These include polynomials from the order of 3 to 10.  As the order of the polynomial increases, you will notice that
the curves tend to snake back and forth and become more “violent”.  Because of the way the coefficients are calculated,
you will find that these curves will often do a superb job of passing through the data points, but they will usually go
crazy between these points and for values of X that are “outside” your data.  

There is a relationship between the number of data points and the order of the polynomial.  Polynomials tend to go
wild when there aren’t enough data points.  If the number of points is less than or equal to the order of the polynomial,
you have a disaster on your hands, while if the number of points is much greater than the order of the polynomial, it’s
likely that the polynomial will be very well behaved within the range of the data.  This is something that you can see
quite easily when you look at the curve; in fact, the process of selecting polynomials can be a certain amount of fun.  

Use these high order polynomials only when there are a lot of data points and when you know that the curve has no
basis in physics, such as when calibrating an instrument.  

Error, Max Error and RMS Error
Once the polynomial is calculated, Benchmark will go through all of the data points and compare the values that the
polynomial will generate with the original data point.  The difference is the error.  

These are too many numbers to have to look at, so Benchmark narrows this down to the maximum error and displays
this, along with the point at which it occurs.  

The other error that is displayed is the RMS error.  This is something like a new, improved version of average, and for
reasons that escape us, it’s generally considered the best way to consider the overall error.  This is done by squaring
each error, adding up all of these numbers and then taking the square root of the errors.  This leads to the name “root
mean square” error which is abbreviated as RMS error.  

Some computer programs automatically select a polynomial with the smallest RMS error.  This is known as the Least
Squares method, but we prefer the Evil Eye Method—look at the curve and decide for yourself if you think the curve
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accurately represents the data.  Sometimes the data will be badly scattered, and it will be immediately apparent.  There
are also times when a high-order polynomial will draw a crooked line through the data points, but the curve outside the
data points will be way off the mark.  

The Curve-Fit Dialog Box
Whenever you need to fit a polynomial to a set of data, Benchmark uses the following dialog box:

This is the standard Benchmark Curve Fit dialog.  Benchmark will do a series of curve-fits on the data.  These are
polynomial equations from order 0 to 10.  As each polynomial is calculated, the curve is plotted on the screen.  This
makes for a lively display of the curves, and gives you a quick preview of each one.   

Once all of the polynomials are calculated, Benchmark will then pre-select a polynomial order, and the method is
frightfully simple: unless the order of 0 or 1 has a lower RMS error, the order of 2 will be pre-selected.  It is then up
to you to explore the other polynomials and decide which one you want to select.  You select an order by using the
Order popup menu.  When you click OK, the currently selected order will be assigned to the polynomial.  

To get a better view of the curve, use the Zoom In and Zoom Out buttons, which will vary in operation depending on
the chart shown.  

If you click on the Errs button, the following dialog box will appear:

This is an aid in selecting the polynomial with the least RMS error.  Because the errors of the highest and lowest order
polynomials will be so large, use the Zoom In and Zoom Out buttons to get a better view of the chart.  

If you click on the Poly button in the Curve-Fit Dialog, this will bring up the Polynomial dialog box, shown below.  
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This shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  
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Chapter 2
Instrumentation

Instrumentation and Calibration
About 80% of the bad data and repeat flight tests result from instrumentation problems.  It is essential that you use
instrumentation with known accuracy so that all variables can be measured correctly.  Always have your instruments
calibrated in a good instrument shop.  Make them plot the error against the indicator reading, at intervals as short as
your pocketbook can stand.  New instruments can have just as much error as old instruments.  Plot error on both the
increasing and decreasing mode for each instrument.  This allows for a hysteresis correction to your flight test data.
Beware of sticking instruments.  

The most important instrument is the airspeed indicator.  For the purpose of these tests, you should borrow or rent a
sensitive airspeed indicator—a two-handed instrument, like an altimeter, with a sweep hand readable in one-mph
increments.  Most instrument shops have one or two laying around.  Explain what you are trying to do, and you may
be able to elicit some sympathy and cooperation.  The sensitive airspeed indicator should be calibrated in 10-mph
increments.  

If you decide to use the airspeed indicator that is already installed in your plane, it’s quite easy to calibrate the
instrument yourself with a few dollars worth of plastic tubing.  You make a water manometer and change the pressure
with a squeeze bulb.  For each speed increment, you write down the column of water, in inches or millimeters.  

In the manual calibration method, you draw a chart of indicated vs corrected airspeed, first by placing points at each data
point and then drawing a smooth curve through these points.  This is something a computer does very well, through a
method known as curve-fitting.  In Benchmark, you enter the data points, and then the program calculates a series of
polynomials of various orders.  You choose the curve that best fits your data, and then the program will use that curve
to determine the corrected airspeed.  This process of fitting curves to data is central to the operation of the Benchmark
program.  

If you don’t calibrate the airspeed indicator and simply use the one you have, all may not be lost.  The first flight tests
will calibrate the airspeed system.  With a calibrated airspeed indicator, this flight test measures the error of the pitot-
static system.  In the absence of the instrument calibration, the flight test will measure the combined error of airspeed
indicator and pitot-static system.  The flight tests will give you reasonably useful information—certainly more useful
than no test at all—as long as you keep the same airspeed indicator.  

The sensitive altimeter should be calibrated in 10’ increments from 0 to 200’, then in 200’ increments above.  

The OAT gauge is important.  Check the ice point at 32°F or 0°C.  Digital OAT indicators with remote sensors are
excellent.  For accurate data, the sensor should be shaded from the sun at all times.  This is quite important for
accuracy since pilots have reported seeing a 5°C difference on a run in opposite directions, just because of sunlight on
the sensor in one direction.  If you don’t make any changes, at least note the position of the sun on each run and use
only those temperatures with the sensor in the shade.  

Since aircraft tachometers frequently indicate lower and lower with age, the tach should be calibrated in 50-rpm
increments from 1500 to 2700 rpm.  A strobe tach is very accurate and can be used to calibrate the tachometer in your
airplane.  There are a number of digital tachometers which are now appearing on the aviation scene.  These are not
terribly expensive and are easily installed.  One digital tachometer uses an optical encoder on the inside of the starter
ring—a strip of reflective tape is placed on the inside of the ring and the encoder shines a light against the tape and
counts the number of reflections.  

Leak-check the system and gauge, and then calibrate the manifold pressure gauge in .5” increments.  These are
notorious troublemakers.  

A fuel totalizer that shows fuel flow and fuel used is best.  A pressure/orifice fuel pressure gauge will work if correctly
calibrated, although this is more difficult since it requires referring to the engine manufacturer’s fuel-flow-vs-fuel-
pressure charts and calculating the aircraft’s weight at each flight run—all of which is simple with a fuel totalizer.  
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If the aircraft does not have an accurate digital clock-timer, you will need a hand-held stopwatch to keep track of the
time during the flights.  

Aircraft manufacturers do all of these things for their flight tests.   We are well aware that you might not go to the
same trouble and expense, but now you know the proper way.

Do-It-Yourself Calibration
It’s very important that the airspeed indicator be calibrated.  While instrument shops have accurate equipment to
calibrate instruments, you can easily calibrate your airspeed indicator with a water manometer.  This requires nothing
more than a few feet of clear plastic tubing, a fitting to join the tubing to the instrument, and optionally a squeeze
bulb.  

It is very important that you do not allow any water to enter the airspeed indicator, or you could ruin it.  Make the
water manometer as shown and then apply pressure, either by using a squeeze bulb or by lowering the instrument.  For
each indicated speed, measure the column of water in inches or centimeters.  

To convert these inches of water or centimeters of water, go the the Calculate menu and choose Units Calculator.  The
following dialog box will appear:

The Units Calculator is provided to assist in the calibration of your instruments.  It shows the relationship between the
indications of an airspeed indicator, altimeter and manifold pressure gauge with a variety of pressure measurements.
The conversion is two-way, that is, you can type an indicated airspeed and get the equivalent pressure, or you can type
a pressure and get the equivalent indicated airspeed.  Use this calculator to convert the inches of water to the actual
airspeeds.  

Entering the Data
Once you have the data for an instrument, it is time to enter this into Benchmark.  

To create a new Benchmark document:
❏ Choose New from the File menu.  The following dialog box will appear:
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❏ Select Instrument to tell Benchmark that you want to create a new instrument file.  When you click OK, the
following dialog box will appear:

Type the information required.  Click OK.  

To enter the calibration data for the instrument, go to the Edit menu and choose Airspeed Indicator, Altimeter,
Tachometer, or Manifold Pressure Gauge (as appropriate) and a slightly different version of the instrument data dialog
will appear:

The Delete button is provided to delete the instrument from an aircraft file.  When you click OK, the following dialog
box will appear:

This is where you type the calibration data for the instrument.  See “Standard Benchmark Data Edit Dialog Box” on
page 10-1 for an explanation of the use of this dialog box.  

Fitting the Curves
The next step is to fit a polynomial to the instrument data.  Go to the Analyze menu and choose Airspeed Indicator,
Altimeter, Tachometer, or Manifold Pressure Gauge (as appropriate) and the following dialog box will appear:
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This is the standard Benchmark Curve-Fit dialog.  Benchmark will do a series of curve-fits on the data.  These are
polynomial equations from order 0 to 10 and will then wait for you to select the polynomial order which best fits the
situation.  To get a better view of the curve, use the Zoom In and Zoom Out buttons.  

If you click on the Errs button, the following dialog box will appear:

This is an aid in selecting the polynomial with the least RMS error.  Because the errors of the highest and lowest order
polynomials will be so large, use the Zoom In and Zoom Out buttons to get a better view of the chart.  

If you click on the Poly button in the Curve-Fit dialog, this will bring up the Polynomial dialog box, shown below,
which shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  

When you click OK, the currently selected order will select the polynomial that will be used for the instrument.  This
means that Benchmark will automatically correct any indicated airspeed, altitude, rpm or manifold pressure for
instrument data.  But to do this, the instrument must be “installed” in the airplane.  But first, select Save from the File
menu to save the document.  Later, after you have created an airplane file, you may install the instrument in the
airplane by choosing Install Instrument from the File menu.  
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Chapter 3
The Propeller

Data Entry
The propeller, at least from your view, is very easy.  There’s not much information that is needed in Benchmark.  

To create a new propeller document:
❏ Choose New from the File menu.  The following dialog box will appear:

❏ Select Propeller to tell Benchmark that you want to create a new instrument file.  When you click OK, the
following dialog box will appear:

Type the propeller manufacturer name, model number or name, and propeller diameter.  If the diameter is not in the
unit of measurement that you want, change it with the Inches/Centimeters popup.  

Blade Thickness applies only if the EHTS (equivalent helical tip speed—see Appendix A) goes over 1000 ft/second.
Unless you know that your propeller tip will be operating at those speeds, it is best to leave Blade Thickness set to
Average.  

Dual rotation propellers are exceedingly rare and haven’t been used in piston-engine aircraft since just after WWII, but
Benchmark has the ability to calculate the efficiency of such a propeller.  

The blade activity factor (described more fully in Appendix A) is very much like the aspect ratio of a wing, but because
the tip of the propeller travels through air faster than the rest of the blade, some adjustment must be made for this.
The propeller manufacturer can supply this information.  

Type the information required.  Click OK.  

Select Save from the File menu to save the document.  Later, after you have created an airplane file, you may install
the propeller in the airplane by choosing Install Propeller from the File menu.  

Calculating Propeller Efficiency
You can calculate the propeller efficiency with the Propeller Efficiency calculator found in the Calculate menu.  This
will calculate the efficiency of a propeller according to the Boeing General Propeller Chart.  

To use the Propeller Efficiency Calculator:
❏ Choose Propeller Efficiency from the Calculate menu.  The following dialog box will appear:
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If you have a propeller file open or have an airplane file open that has a propeller installed, the propeller specifications
will already be filled in.  Changing these does not change the specifications of the propeller file or propeller installed in
the airplane.  

Type in the boxes for Vtas, engine power, pressure altitude, temperature, propeller diameter, RPM, blade activity
factor, and number of blades.  The speed is also handled with a toggle button, click on the Vtas button to change the
speed to Veas.  (Remember, equivalent airspeed is indicated airspeed with no error—just think of it as “indicated”.)  

If ISO Standard is checked, the temperature for the ISO standard atmosphere is automatically calculated.  De-select ISO
Standard to type your own temperature.  Blade thickness applies only if the EHTS goes over 1000 ft/second.  When the
tips of the blades go supersonic, efficiency deteriorates rapidly, and thick blades do so quicker than thin blades.  

The propeller efficiency is plotted against for J/Cp^1/3 (abbreviated as J_Cp and J/CP in the dialog box) or Cpx
according to the setting on the Plot Eta Vs toggle button.  Click on the toggle button to change the setting.  When the
line is plotted as a gray line, this means that the values being plotted are outside the values represented on the Boeing
General Propeller Chart.  Similarly, any values that are not represented on the Boeing chart are shown in italics.  These
out-of-range values should should not be taken seriously.  The curves that are plotted are not simply the curves from
the Boeing General Propeller chart; they also include the other variables of ∆Eta TAF and ∆Eta TS—which make
adjustments for the total activity factor and tip speed.  

See Appendix A for a complete discussion of the calculations involved in propeller efficiency, but here’s an overly
simple explanation.  Think of J/Cp^1/3 as the speed of the airplane and Cpx as the amount of power put into the
propeller.  When you are plotting Eta vs J/Cp^1/3, change the speed and note how the efficiency moves along the
curve.  When you are plotting Eta vs Cpx, try changing the amount of power or the number of blades and observe how
the efficiency moves along the curve.  If the propeller is properly selected for the engine/airspeed combination, you
should find the propeller efficiency near the peak of both curves.  
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Chapter 4
The Engine

Entering Engine Power Data
You need to know the power that the engine is putting out at each power setting.  This information is very important,
and it must be accurate.  Major aircraft companies use a torquemeter, sometimes with a computer in the cockpit, to
obtain precise information about the power of the engine.  These devices are expensive, and if you don’t have access to
one, so you will have to use the engine performance charts supplied by the engine manufacturer.  

To model the engine power, Benchmark uses three curves which you fit to the data of the engine performance.  

Engine manufacturers publish sea level and altitude performance charts.  We’re only interested in the sea level portion,
shown below, in which the engine power is plotted against manifold pressure for a number of engine rpms.  To model
the engine in Benchmark, you must first use this chart to get the power data needed.  

Hpm
HP1

HP2

MAP1MAP2

For each diagonal line representing a constant rpm, carefully note the power (HP1 and HP2 in horsepower or kilowatts)
and manifold pressure (MAP1 and MAP2 in inches of mercury or Bar) at two points.  Because Benchmark will be
analyzing the slope of the lines, it is desirable to use two points that are far apart—normally the lowest and highest
readable points for each rpm.  

You also need to note the maximum power available (HPm) for each rpm.  For normally aspirated engines, the curved
line representing the maximum manifold pressure will curve to the left, but for turbocharged engines, the line will
curve to the right.  In each case the line will originate at 29.92 inches Hg (1.00 Bar) at 0 rpm.  In many cases, the
engine manufacturer will not show the maximum power available at the lower rpm’s, so you will have to extend the
lines and curves to get the numbers required to model the engine power.  

To create a new Benchmark engine document:
❏ Choose New from the File menu.  The following dialog box will appear:

❏ Select Engine.  The following dialog box will appear:
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Type the information required.  Min RPM is the engine speed that you would normally consider as the minimum
cruising rpm, and for most airplanes this is a limitation of the propeller’s ability to go to a high-enough pitch without
hitting the stops.  The Min RPM is used in Benchmark for the miles per gallon charts.  Idle RPM is used in
Benchmark to establish the lowest rpm that you will be allowed to type.  When you have entered this information,
click OK, and the Power Data dialog box will appear:

When the Power Data dialog box first comes up, it will show an unusual setting of 0 power at 0 RPM and a manifold
pressure of 29.92 inches of mercury.  All engines exhibit this characteristic of producing no power when the engine is
not running, and this “zero data point” is useful in the modeling of the engine power.  If you do not want to use this
“zero data point”, delete the row of data—click on the row number and then click on the Delete icon.  See “Standard
Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the use of this dialog box.  Type the engine
power data points and then click OK.

Analyzing Engine Power Data
The next step is to analyze this data.  Choose Engine Data from the Analyze menu.  Benchmark then goes through a
process of fitting curves for three curves, HPm, FHP and MPm.  It will come up with polynomials from order 0 to 10
and then will wait for you to select which polynomial order best fits the situation.  As long as a 2nd order polynomial
is a better fit than one of order 0 or 1, Benchmark will always pre-select a 2nd-order polynomial, since it is our
experience that this is the best solution in almost every case.  

With each of the three curves, you will have an identical screen.  The Order popup allows you to select the order of the
polynomial.  When you select a different order, the curve for the new order is plotted on the screen.  
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To get a better view of the curve, use the Zoom In and Zoom Out buttons.  

To print a chart, click on the Print button. (Not working at this time.)

Clicking on the OK button tells Benchmark to accept the currently selected order as your choice for the polynomial for
that curve.  If you have the order selected as 5, then the polynomial will be of that order and this polynomial will be
used for all engine calculations.  

If you click on the Errs button, the following dialog box will appear:

This is an aid in selecting the polynomial with the least RMS error.  Because the errors of the highest and lowest order
polynomials will be so large, use the Zoom In and Zoom Out buttons to get a beter view of the chart.  

If you click on the Poly button in the Curve-Fit Dialog, this will bring up the Polynomial dialog box, shown below.  

This shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  

The Theoretical Engine Curves
In selecting the polynomials for the engine power curves, it may help you to know what the curves should look like.  

HP

RPM

friction horsepower
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The friction horsepower is the friction of the engine and is normally considered to increase exponentially with the
engine rpms as shown above.  At zero rpm, the friction should also be zero, and should rise with increasing rpms,
probably as a square of the rpm.  

HP

RPM

maximum
horsepower

indicated
horsepower

The maximum horsepower should begin at zero horsepower at zero rpm and then rise in the type of curve shown
above.  The standard engine theory states that the maximum horsepower of an engine equals the indicated horsepower
less the friction horsepower.  When plotted on a chart, the indicated horsepower is a straight line, and it is easy to
understand how friction horsepower when subtracted from that straight line would produce the curve shown above for
maximum horsepower.  

MAP

RPM

max manifold pressure

For normally aspirated engines, the maximum manifold pressure should begin at 29.92 inches of mercury at zero rpm
and should decrease exponentially as the rpms increase.  It is easy to understand that manifold pressure will be the
ambient air pressure less the friction of the induction system, and that the friction will increase exponentially as the
flow of air increases.  

MAP

RPM

max manifold pressure

For turbocharged engines, the maximum manifold pressure should also begin at 29.92 inches of mercury at zero rpm,
but it should rise exponentially with the rpms.  As with normally aspirated engines, the friction in the induction
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system will increase exponentially as the flow of air increases, but on the positive side of the ledger, the turbocharger’s
ability to pump more air will also increase exponentially with the rpms of the engine, and this will be the more
powerful of the two forces.  

Entering the Manifold Pressure Limit

Power 2

MAP1 MAP2

Power 1

limiting manifold pressure
for continuous operation

Many engine sea level charts have a straight line called “limiting manifold pressure for continuous operation” as shown
above.

For What It’s Worth Department.  The purpose of this line, ostensibly, is to keep you
from lugging the engine and damaging it.  In some cases the manifold pressure limit is related to
an engine vibration mode, and in most such cases, this reason is noted on the chart.  In most other
cases, the limit is related to detonation.  In developing Benchmark, we were curious if this line
was a line of constant BMEP—it isn’t—or some other calculable function.  

An engineer at Lycoming was delightfully candid—“We have no idea where the line came
from”—and said that all of his attempts to back into a rational basis for the line have been
unsuccessful.  (Remember, four-cylinder Lycomings were developed 30 years ago, and the engineer
who drew the line retired long ago.)  The engineer also pointed out that on some of their larger
engines, the turbocharged versions are regularly operated above the limiting manifold pressure for
the otherwise-identical normally aspirated engine.  

Detonation is a function of BMEP, RPM, temperature and the fuel/air ratio.  It’s possible that a
very bright engineer studied the problem and concluded that this line provided a safe limit that
would reliably keep you out of detonation, but it’s equally possible that the line is arbitrary; that
an engineer simply slapped a ruler on the paper, drew a line, and muttered to himself, “That ought
to keep the idiots out there out of trouble!”  Whatever the rational for the line, in Benchmark, we
simply treat the limit as a linear relationship between manifold pressure and engine power—a line.  

Using the engine manufacturer’s engine chart, locate two points on the manifold pressure limit line, then choose
Manifold Pressure Limit from the Edit menu.  The following dialog box will appear:

Type the numbers required.  Almost no error-checking is presently performed on the numbers: point 2 must be above
and to the right of point 1.  To have “no line”, i.e. no manifold pressure limit, zero all of the numbers.  



Benchmark

Entering Fuel Flow Data
Benchmark has the capability of modeling the fuel flow of the engine.  Like engine power, this is handled by fitting a
polynomial to the data, but in this case the data is not a curved line, but rather a curved three-dimensional shape, just
like propeller efficiency, so the curve is represented by a multivariate polynomial.  

Benchmark models fuel flow for three mixture settings—full rich, best power and best economy—thus it requires three
sets of data, represented by fuel flow vs engine power and engine rpm.  You get this data from the engine
manufacturer’s charts.  Most manufacturers show the best power and best economy fuel flow in the form needed, that
is, they chart fuel flow vs engine power for lines of constant rpm.  

With the data for full rich, engine manufacturers often plot the fuel flow vs manifold pressure for lines of constant
rpm.  This is easily handled by using Benchmark’s Engine Power calculator to convert those manifold pressure/rpm
settings into the desired power/rpm data.  If you have a fuel totalizer, you can also just go fly your plane, set the
mixture at full rich and write down the numbers at various power settings.  

Once you have written down all of the fuel flow data required, select Full Rich Fuel Data, Best Power Fuel Data or
Best Economy Fuel Data from the Edit menu, and the following dialog box will appear:

Enter the data required.  See “Standard Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the use of
this dialog box.  

If you are editing the best power or best economy fuel data, when you click OK, the following dialog box will appear:  

Most engines have a maximum power above which best power or best economy leaning is not permitted.  This
number is used by Benchmark in the engine power calculator, in the airplane speed calculator and in some of the
performance charts.  Enter the maximum power for best power or best economy leaning.  

Analyzing Engine Fuel Data
Because there are three sets of data, you have to follow this procedure three times.  From the Analyze menu, choose
Full Rich Fuel Consumption, Best Power Fuel Consumption or Best Economy Fuel Consumption.  The following
dialog box will appear:
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This dialog box works like the normal Benchmark Curve-Fit dialog, except that in this case you are dealing with three-
dimensional (X-Y-Z) data.  To protect you from the confusion of which order applies to which variable, you are
allowed to select the polynomial order only for the curve shown.  Benchmark will pre-select an order of 2,2 and will
calculate that polynomial.  

To see the relationship between RPM and fuel useage, select the RPM button, and the display will change to:

Because of the nature of fuel flow curves, in most cases, a polynomial of the order of 2,2 is best.  If you select any
polynomial orders which have not yet been curve-fitted to the data, the Calc button will be activated.  When you click
on the Calc button, Benchmark will fit a polynomial to that data—but be warned:  this process is very slow for high-
order polynomials.  

The process of fitting these multivariate polynomials is an excruciatingly complex series of calculations that really
does deserve that over-used description of ‘number-crunching’.  The data structures required are very large, and if you
select a high-order for one of the variables, you will notice that your choices for the other will be limited.  This
restriction is because of the limits of the size of the data structures.  

Warning.  Each polynomial order set requires about 32K of memory, so if you attempt to
calculate all possible orders, this will require about 2.7MB of memory.  At this time, Benchmark
does not check for out-of-memory conditions, and will crash if you attempt to calculate too many
polynomial orders.  

To print a chart, click on the Print button.  (Doesn’t work yet.)  

When you select OK, the currently selected orders for the polynomial will be used to represent the fuel flow of the
engine.  

If you click on the Poly button, this will bring up the multivariate Polynomial dialog box, shown below:
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This shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  

In order to fit a polynomial to the fuel data, it’s a good idea to know what the curve should look like.  It’s all too easy
to type in the numbers, fit the curve and sit back fat, dumb and happy with a perfect curve fit of nonsense—we call
this data-set myopia.  The first thing you should do is to take a step back from the short curve segments that you see
on the screen.  You do this by entering phony data points, and you can use these data points to tailor your curve.  It’s a
process that’s much like tugging on the edges of a sheet to get the middle of the bed smoothed out.  

Throughout this process you will have to enter data points by using the appropriate commands in the Edit menu, and
then you go to the Analyze menu to fit a curve to the new data.  

Sorree.  This process is a bit awkward because you have to go back and forth between the two
dialog boxes, but—for now at least—it’s something you will have to live with because allowing
you to edit the data at the same time you are fitting the curves would be a phenomenally complex
matter to include in Benchmark.

Start by entering this data point:  Power = 0, RPM = 0 and Fuel Flow = 0.  Now stop and think about this.  It makes
sense that when the engine is not turning and when it it not putting out any power, it should also not use any fuel at
all.  

Now analyze the curve again.  Look at the curve and just think about how fuel flow should vary with power and rpm.
Let’s first consider fuel flow vs engine power at lines of constant rpms.  Because the engine is turning the same speed,
there should be almost no difference in friction, and that suggests that the line should be a straight line.  But the
change in power also means that the engine will be operating at a different compression ratio and that would probably
make the line form a curve.  In fact, all of the fuel flow charts that we’ve seen do have a slight upward curve.  

So take a flexible ruler, a piece of cardboard or a magazine and bend it to fit the curve for the maximum rpm line (2700
rpm for Lycomings, and we’ll just use that number here to mean the maximum rpm).  Hold this up on the screen (or
print out a chart and work with that), flex it to fit the curve and pick a point at 0 power where this curve would be if
there is a smooth consistent curve all the way.  Enter this data point and then analyze the curve again.  

Lines of Constant Whatchamacallits.  In the fuel curve-fit dialog boxes, Benchmark plots
lines of constant power or constant rpm.  It looks through the list of fuel data, and draws one line
for every value that is present.  To get a nice presentation, you should use the same values for
power or rpm for your phony data points.  So it doesn’t matter if you use phony data points at 0,
1 or 2 rpm or 0, 0.01, or 0.02 horsepower, but pick one value and use it consistently.  

Now go back and analyze the curve again, but this time plot fuel flow vs rpm—click on the RPM Order button.
Because you have entered data for 0 horsepower, Benchmark will plot this curve.  We’ve already decided that the engine
will not use any fuel when it’s not turning and producing no power.  And you’ve entered a phony data point at 0 power
and 2700 rpm.  That makes sense because, when the engine is turning 2700 rpm, fuel would be consumed by the
friction just to turn the engine over and not leave any power available “outside” the engine.  
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So the line of fuel flow at 0 power is really a measure of fuel used to offset the friction created by turning the engine.
Friction, like so many other things associated with speed, increases with the square of the rpm, so you would expect a
slight upward curve to the line.  In fact, what we’ve found by looking at these curves is that they do curve, but they
curve less than you might think—see the example above.  So use your flexible ruler and create a couple of phony data
points at 0 power to make this curve behave.  

Now ask yourself this question:  As you increase the engine power, should the curves look any different?  We believe
that the change in friction with rpm is independent of engine power, thus the curves should all be parallel, as shown
above.  If you only think of the friction involved, this logic is easy to follow, but your mind is likely to rebel at the
thought of the fuel flow of an engine that is not turning (0 rpm) and which is still producing maximum rated power.
It will help you if you simply think of it as an engine that has no friction, no moving parts, and yet which by burning
fuel in a chamber is capable of producing horsepower—something akin to an ever-expanding balloon filled with a
burning fuel-air mixture.

Once you accept that these lines are all of the same slope and curve, this means that the curves of constant rpm are
parallel curves as shown above.  Once you accept these things, everything gets easier, and you can start entering phony
data points for 0 rpm (in the example above, there’s a point at 72 and 160 hp).  It also helps to pick an rpm that is
about half of the engine’s maximum rpm and make up some phony data points.  In the example above, we’ve created a
couple of phony data points at 1400 rpm.  

Calculating Engine Power
With the engine now analyzed, you can now calculate the engine power at any condition.  

❏ Choose Engine Power from the Calculate menu.  The following dialog box will appear:
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Type values for manifold pressure, rpm, pressure altitude and temperature in the appropriate boxes.  If ISO Standard is
checked, the temperature for the standard atmosphere will be automatically entered by Benchmark in the temperature
box, and you cannot change the temperature as long as this is checked.  If Full Throttle is checked, the (still air) full
throttle manifold pressure for that rpm/pressure altitude combination will be automatically entered by Benchmark.  

Use the popup menus to change the units of measurement.  

Charting Specific Fuel Consumption vs RPM
Now that the fuel data is modeled, let’s take a look at it.  Here you’ll learn a lot about which are the most economical
power settings.  

To see this chart,
❏ Select Specific Fuel Consumption vs RPM from the Chart menu.  The following dialog box will appear:

A chart is drawn for lines of constant power for Full Rich, Best Power or Best Economy.  If Best Power or Best
Economy is selected, the highest power that will be charted will be the maximum best-power power or the maximum
best-economy power.  The lines will be clipped at the bottom for the line of limiting manifold pressure for continuous
operation.  If you want that limit line drawn on the chart, select Limit Line.  

Min RPM and Max RPM determine the range of rpms that are charted.  Because most propellers hit the stops at low
rpm settings, it is not usually practical to operate at extremely low rpms.  There are limits placed on the range of
settings for the engine speeds:  Max RPM cannot be greater than 1.5 times the engine max rpms or must be at least
100 rpm more than Min RPM, and Min RPM cannot be less than engine idle speed and must be at least 100 rpm less
than Max RPM.  Because of this error-checking, Min RPM and Max RPM may be difficult to type.  If you encounter
problems, replace just one number at a time.  
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Chapter 5
The Airplane

Data Entry
To create a new aircraft document:
❏ Choose New from the File menu.  The following dialog box will appear:

❏ Select Aircraft to tell Benchmark that you want to create a new aircraft file.  When you click OK, the following
dialog box will appear:

❏ Type the information required.  

The low cruise weight is the lowest weight at which you would normally cruise (empty weight + pilot weight + low
fuel weight) and is used in the miles-per-gallon charts.  

The payload is for Cafe 400 scoring.  

Installing Engine, Propeller and Instruments
Benchmark operates on the concept of ‘installing’ engine, propellers and instruments into an airplane.  In reality, what
occurs is that you bring the data from those files and put it in the airplane file where all of the data is stored together.
Once you install the files, you must still save the airplane file or the information is lost.  Benchmark does not store any
information to disk unless specifically instructed to do so with a Save command.

To install an engine:
❏ Choose Install Engine from the File menu.  A standard Open File dialog box will appear.  

❏ Select an engine from the list that is presented.  

To install a propeller:
❏ Choose Install Propeller from the File menu.  A standard Open File dialog box will appear.  

❏ Select a propeller from the list that is presented.  

To install an instrument:
❏ Choose Install Instrument from the File menu.  A standard Open File dialog box will appear.  

❏ Select an instrument from the list that is presented.  

To save these changes:
❏ Choose Save from the File menu.
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That’s all there is to it.  It’s a lot easier to install an engine or propeller in Benchmark than in real life.  You may
change engines, propellers and instruments just as easily and at any time.  
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Chapter 6
The Pitot-Static System

The Pitot-Static System Calibration
There are three flight tests: pitot-static system calibration, drag polar and climb—normally done in that order.  If you
wish, all three flight tests may be flown on the same flight.

It is absolutely essential that you calibrate the error of the pitot-static system.  Generally, the pitot tube is a minor
problem, since a well-designed pitot tube has little or no error up to about 15° to 17° angle to the relative wind.  The
static ports are very sensitive to cross-flow, shape and location on the aircraft.  As shown in the illustration below,
tests on other aircraft have shown errors of 5%—10% in some cases—and this is in addition to the airspeed indicator
instrument error.  If you change the location, shape, line size or length, of either the pitot or static system, some
change in the airspeed system calibration will result and a new airspeed calibration should be run.  
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There are four basic methods used in calibrating the pitot-static system.  The theodolyte method (or altitude fly-by
tracking) is the most precise but requires a sophisticated set of equipment.  The trailing static (cone or bomb method)
has problems with the aircraft flow fields which vary with line sag and length.  The pacer aircraft method, checking
against a known aircraft, is the least accurate.  The most practical method is the speed-course method.  

The Flight Test
Select a speed course of about two miles length, with obvious markers at each end of the course.  A straight road
intersected at each end by another road is a good high-visibility approach.  Ideally, you must know the exact surveyed
distance between markers.  Your county surveyor should be able to help with exact point-to-point distances.  

Be sure the terrain is level, clear of obstructions and as close to sea level as possible to minimize density altitude
corrections.  A long lake with shoreline or fixed markers of known distance apart is ideal.  Your altitude above the
surface should be at least 1-1/2 to 2 span lengths—100’ is a good number if the water is not glassy.  Getting closer to
the surface gets you into ground effect and causes pressure errors in your static system.  Each speed run should be made
with great precision in holding constant indicated airspeed and altitude, using power as necessary.  It is extremely
important that there be no wind and smooth air.  Even if this is the case, two runs in opposite direction should be
made for each speed point.  

Because the pilot’s attention is required to hold the speed and altitude, a second crewmember is a must to look out for
obstructions, record data and trigger the stop watch.  Alignment of two fixed dots, one on the wing tip and one on the
canopy, is very useful in getting the most accurate times between markers.  

The Pitot-Static Calibration Flight Data Form is provided in Appendix C.  Make copies of the form and record the
results of the flight tests.  In the form, you should record the directions of each run, i.e. North, South, East or West.  

Many aircraft flight manuals show the pitot-static correction for the airplane with landing gear and flaps down, so if
you want that information, you should fly the airplane in that configuration at appropriate speeds.  

Flight Test Data Reduction
After the flight test is complete, you will need to reduce this data to Vias and Vcas.  To assist you with this, a pitot-
static calibration calculator is provided to analyze pitot-static flight test data.  
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To use the pitot-static calibration calculator:
❏ Choose Pitot-Static Calibration from the Calculate menu.  The following dialog box will appear:

A typical pitot-static calibration flight test is made over a speed course of a known length.  The aircraft is flown at a
constant indicated airspeed and the elapsed time over the course is recorded.  To compensate for winds, two runs
through the course in opposite directions are normally done.  If two runs are used, the times are averaged to calculate
the ground speed.  

Below the indicated airspeed and pressure altitude are listed the corrections for instrument error, provided the
instruments have been calibrated and are represented by polynomials (see Chapter 2 “Instrumentation”).  The correction
to the outside air temperature (OAT) is for adiabatic compression, however unlike other calculations in Benchmark this
correction is based on ground speed and is computed directly without iteration, but you have the option of turning this
correction off.  The calibrated airspeed (Vcas) is computed from the ground speed based on the pressure altitude and
corrected outside air temperature.  

Use this calculator to reduce your pitot-static flight test data to a simple set of ViasUncorr and Vcas speeds.  

Pitot-Static Flight Test Data Entry
To enter this data:
❏ Choose Pitot-Static Data from the Edit menu, and the following dialog box will appear:

Enter the data required.  See “Standard Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the use of
this dialog box.  The Vias data required is for the indicated airspeed uncorrected for instrument error.  When the data is
analyzed, the correction for instrument error is made automatically by Benchmark.  

The Reset button allows you to ‘decalibrate’ the pitot-static system.  If you have entered data for the pitot-static
system, then selected Pitot-Static from the Analyze menu and curve-fitted a polynomial to the data, the Reset button
allows you to undo the curve-fitting while still retaining the pitot-static data.  

Fitting the Curve
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To fit a polynomial to the pitot-static system data,
❏ Choose Pitot-Static from the Analyze menu, and the following dialog box will appear:

This is a standard Curve-Fit dialog box.  Use the methods you have already learned to select a polynomial order that
best fits the curve.  When you click OK, the currently selected order will be used by Benchmark to correct for the pitot-
static system error.  

Charting the Pitot-Static System
In the future we intend to add the capability of plotting ∆Vpc vs Vcas/Vias.  This will be known as the Airspeed
Calibration Plot.  

Another possible chart will be the more familiar Vcas vs Vias graph for the flight manual.  
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Chapter 7
Induction System Ram Recovery

Ram Recovery
When an aircraft flies through the air, the air that impacts the plane also forces itself into the induction system and can
boost the manifold pressure.  The potential boost is a function of indicated airspeed; indeed the airspeed indicator is
nothing more than a pressure gauge with the dial face painted with mph, knots or km/h.  The efficiency with which the
induction system converts this available pressure into a boost of manifold pressure is known as the ram recovery.  

The Flight Test
The ram recovery flight test is the simplest of all tests.  All you have to do is to fly the airplane at full throttle and
write down four numbers:

1.  The pressure altitude.  Set the altimeter to 29.92 in Hg/1000 mB and note the altitude of the aircraft.
2.  The indicated airspeed.  
3.  The engine rpm.
4.  The indicated manifold pressure.  

All of these should be indicated.  Benchmark will correct each for instrument error as well as correcting the airspeed for
pitot-static system error.  

Data Entry and Analysis
The ram recovery flight test data is entered and analyzed in a single operation.  
❏ Choose Ram Recovery from the Analyze menu.  The following dialog box will appear:

From data collected on a flight test, type the pressure altitude, indicated airspeed, engine rpm and the full throttle
manifold pressure observed.  The ram pressure is a function of the indicated airspeed, and this pressure is listed to the
right of the airspeed.  

The manifold pressure must be in a range, starting with the still air maximum manifold pressure for the engine at the
rpm specified and increasing by the additional pressure available from the ram of the air entering the induction system.
Ram Recovery is expressed as a percent between 0 and 100.  

When you click OK, this data and the calculated ram recovery become part of the airplane data and will be stored in the
airplane file when you save.  
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Chapter 8
The Drag Polar Test

The purpose of the drag polar flight test is to calculate two magic numbers for the airplane: the Cdo and Oswald E.
When you have these two numbers, the performance of the airplane is mathematically predictable.  

In order to get these numbers, you fly the airplane at the full range of speeds, from very slow to very fast.  What you
really want to know is the coefficient of drag and coefficient of lift at each speed, so not only do you need to know the
speed at each point, you also need to know the weight of the airplane at that moment.  

All of this information must be very accurate, or your time will be wasted and the results of your test will be
inaccurate.  You should already have calibrated your instruments and your pitot-static system so that your data will be
accurate.  

You need to practice accurate flying techniques so that the data will be representative of the aircraft.  You need to be
very patient and take your time.  This sort of flight test work is very boring and cannot be rushed.  You also need
steady air to fly in, with no vertical currents, and a reasonable (standard lapse rate) temperature pattern.

Airplane Test Configuration
During the performance flight tests, you must identify and hold constant the airplane drag configuration.  Make no
changes to the airplane’s external or internal configuration before, during or after testing.  The only exception to this is
when the objective of the flight test is to measure the effect of a change.  Before beginning the flight test, at least
check the following items:

• Make sure the gear goes to the same “up” position every time.
• Make sure the gear doors “seal” in the up position.  
• Engine cowling joints and baffles are set for minimum leakage.  
• Propeller blades and leading edges are smooth and nick-free.  
• Airplane clean—no mud, bugs or dirt.  
• Propeller governor—no RPM fluctuations at constant speed and power in level flight.  
• Weigh aircraft and crew accurately, and keep the same for every flight.  
• Check the pitot and static system for zero leakage for 5 minutes and no bugs, dirt or water in

the system.  If in doubt, blow out the system with dry air (after removing lines from 
instruments), reconnect and recheck for leakage.  

• Check everything else you can think of which might cause errors or unknowns in your test data.  

If you are using a fuel totalizer that is calibrated in pounds, you can preset the totalizer to the aircraft gross weight,
including fuel and flight crew, prior to starting the engines.  Then, as fuel is burned, the remaining weight is the
aircraft gross weight.  Thus, you can directly read and record the aircraft gross weight at any time in the flight.  

Drag Polar Flight Test
Having calibrated your instruments and your pitot-static system, you can determine your airplane’s speed with
reasonable accuracy.  The next flight test is the “drag polar” in which you will fly the airplane at a series of pre-selected
power settings and record the speed of the airplane.  

The Drag Polar Flight Test Data Form is provided in Appendix C.  Make copies of the form and record the results of
the flight tests.  Each flight run should be numbered for that day.  In the remarks column, record anything out of the
ordinary.  

If you have a fuel totalizer, it is quite easy to determine the weight of the aircraft at each point, but if you do not, you
will have to go to extra trouble so that you can calculate the weight of the aircraft with precision.  This means that
you must record all events, i.e. start engine, takeoff, climb, run No. 1, 2, 3, etc., descent, and engine shutdown.
Always record takeoff time, takeoff weight, time at each significant power change (and new power setting and fuel
flow) plus time at the beginning of each test point.  When you are trying to get a weight for a particular point in
analyzing your test data, such things become very important.  Always record the time at which testing is finished,
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descent to home base initiated, time of engine shut-down and fuel added to bring the airplane back up to its takeoff
weight.  This may seem like a lot of work, but it is better than trying to make sense out of a vaguely defined test
point or having to go through a whole flight test again.  

And if you don’t have a fuel flow gauge, you will have to obtain the fuel flow from the engine manufacturer’s fuel
flow curves.  

Remember that if your aircraft sits out in the sun several hours before flight (especially in the summer months) and
gets hot, the fuel will expand and leak out of the vents, evaporate and the airplane will weigh less at takeoff than if
takeoff were performed immediately after filling the tanks or removing the airplane from the hangar.  In other words,
know your takeoff and landing weight.  

It is always best to fly a polar (the entire series of points) at one rpm, varying power with manifold pressure.  Usually
this is easiest at maximum rpm, since it gives the widest range of power and speed combinations.  Your drag-polar
should include at least 10 points, from maximum speed down to the lowest speed you can handle.  Prop stops and
airplane stability are a factor at low speeds.  If you hit the prop stops, the governor can no longer maintain constant
rpm, because below that speed the blade angle can no longer decrease, and you are trying to fly with an essentially fixed
pitch prop.  A stabilized speed-power (polar) point becomes exceedingly difficult in this case because even small
changes in speed cause related changes in rpm, which in turn cause related changes in power.  

In setting up each polar point, set up manifold pressure and rpm about 200 to 300 feet above the selected test altitude
(historically 6000’ to 8000’ density altitude is a good choice) and lean to best power mixture (peak EGT plus 100°F).  

Precision Mixture Adjustment.  Most pilots allow little or no time for EGT gauge response,
but you should take the extra time to accurately set the mixture.  When using an EGT gauge with an
adjustable scale or pointer to record the peak EGT, you should re-establish the peak at each power
setting.  All of this extra care in setting the mixture is required to precisely set best power mixture
and to obtain the correct fuel flow.  It may take an extra 5 to 10 minutes at each power setting to
accurately set the mixture.  Of course, this same care in setting the mixture would be required in
routine flying to obtain the performance and fuel consumption predicted from the flight test.  As any
experienced test pilot can tell you, this type of flight testing gets very boring very quickly, but it is
this extra measure of patience and care that separates the professionals from the amateurs.  

When the power is set, let everything settle down and then gently dive to the selected test altitude.  Then with your
fingertips plus a little trim as required, allow the airplane to slow down slowly from the dive, while very gently
maintaining constant altitude, until you reach a stabilized level flight condition.  

Remember, the airplane knows when it is stabilized better than you do.  An excellent clue is to watch airspeed and
altitude very closely.  When the altitude goes up 5 or 10 feet, the airspeed should go down very slightly—say 1 mph or
so—and when the altitude goes down 5 or 10 feet the airspeed should go up 1 mph or so, without you touching
anything.  This process should never continue in one direction or go divergent.  If it does, go back up and start the
process over.  If the stabilized flight condition prevails for 3 minutes with only fingertip nudges to keep altitude
constant, you can record your time, speed, altitude, temperature, manifold pressure, rpm and fuel flow.  If you want a
little extra insight, record the oil temperature and CHT.  

Be prepared for a slow process in setting up the airplane in the stabilized flight.  It will normally take 2 to 5 minutes
to stabilize and then another 3 minutes to fly in stabilized flight.  It is normal for expert test pilots spend 10 minutes
per point.

Be sure there is no visible moisture, drizzle or clouds forming at your flight test altitude, and that the air is glassy
smooth.  Do not test where there are imminent or recent frontal passage conditions since you can be sure of flying in a
slowly rising or descending air mass.  On the climb to the test altitude, record the temperature at each one-thousand-
foot altitude to check the lapse rate to be sure there are no strong thermals or inversions.  

Have a lookout (flight engineer) riding shotgun and recording data for you.  If you are doing it right, you are not going
to see much outside of the cockpit.  
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One of the more curious facts of performance flight testings is that you cannot know how fast you are going unless
you know the temperature of the air, but the friction of the air against the temperature probe and the compression of
the air in front of the probe heat the probe slightly through a process known as adiabatic compression.  Thus you
cannot know what the temperature is unless you know how fast you are going.  This circular reference is easily handled
by iteration in Benchmark.  Don’t laugh this off as insignificant.  At the speeds you will be flying this will amount to
several degrees.  This flight test analysis method is mathematically rigorous, and if you want accurate results you must
use the most accurate methods.  

In the ideal situation, you will note the outside air temperature at each run of the flight test, but as an alternative
method, you may note the temperature at one pressure altitude and indicated speed and then use this temperature for
each run.  If you use this method, you must fly all of the runs at the same pressure altitude, and you must be certain
that the temperature of the air does not vary.  You have an option in Benchmark of turning off the temperature
correction for adiabatic correction.  If you do this, you should at least use Benchmark’s atmospherics calculator to
correct the temperature that you use.  

Drag Polar Flight Test Data Entry
To enter the drag polar data into the airplane file:
❏ Choose Drag Polar Tests from the Edit menu, and the following dialog box will appear:

❏ Click on New, and the following dialog box will appear:

❏ Type the information required.  

The aircraft weight is the weight at the start of the first run of the flight test.  You must calculate this by taking the
aircraft weight (including crew and equipment) prior to the flight and subtracting the weight of the fuel burned.  

When you click OK, the following dialog box will appear:
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❏ Type the information required in the data entry box of the Edit bar.  See “Standard Benchmark Data Edit Dialog
Box” on page 10-1 for an explanation of the use of this dialog box.  

Drag Polar Data Reduction
To analyze the drag polar of an airplane:
❏ Choose Drag Polar from the Analyze menu.  The following dialog box will appear:

❏ Select a flight test.  The following dialog box will appear:

Benchmark will solve for Cdo and Oswald E and will plot the data points on the screen in a straight line by plotting
Cd vs Cl2.  This process only takes a few seconds, and you may be interested to know that prior to Benchmark, this
process of solving for Cdo and Oswald E would take a trained engineer at least 4 hours of painstaking work, and the
manual process would have been less accurate.  

The Cdo—also known as the profile drag coefficient—is the drag of the airplane at zero lift.  This is impossible to
achieve in actual flight, but it is one of the two critical numbers you need to know about the airplane.  The other is the
Oswald efficiency factor.  Years ago the brilliant aerodynamicist Prandtl developed the Prandtl wing theory which
expressed the lift and drag of an airplane in terms of wing area, coefficient of drag, coefficient of lift, aspect ratio, etc.
All of Prandtl’s work was on elliptical wings, and it was soon discovered that other wings did not behave exactly the
same.  The Oswald efficiency factor cured this.  It is essentially a glorified fudge factor.  If you have an Oswald
efficiency factor of 0.65, this means—roughly—that your wing is 65% as efficient as an elliptical wing.  
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For design purposes or if you want to engage in the practice of wishful thinking, you can type your own values for
Cdo and Oswald E, and these will be used for subsequent speed calculations.  Click on the Revert button to come back
to reality.  

To print a chart of this, click on the Print Chart button.  To print a report, click on the Print Report button.  (The
report will only be readable if you select landscape printing.)

Use the Zoom In and Zoom Out buttons to get a better look at the data points.  

To see the numbers involved in the calculations, click on Data and the following dialog box will appear:

Benchmark will step through each run of the drag polar flight test and will show on the screen all of the pertinent data
and all of the numbers used in the calculations.   

Speed Calculations
An airplane in flight behaves according to a series of mathematical calculations, and the Cdo and Oswald E are the two
critical factors which define the airplane.  With these now part of the airplane file, Benchmark is able to predict the
performance of the aircraft.  

To calculate the speed of the aircraft:
❏ Choose Airplane Speed from the Calculate menu.  The following dialog box will appear:

Enter the settings you want and click on the Calc button to calculate the airplane speed.  The manifold pressure is
calculated in two different ways.  If Full Throttle is turned off, the manifold pressure is for still air; that is, the
induction system ram recovery is not calculated.  If Full Throttle is selected, the induction system ram recovery is
included, and the manifold pressure will be increased at each speed according to the ram available and the ram recovery
of the induction system.  
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Because it is possible to assign a manifold pressure than is higher than possible at the altitude, you should use the full
throttle setting from the Percent Power popup after any change in altitude.  If you want to use a standard percent
power—55%, 65% or 75%—this is also available from the percent power popup.  

If the fuel flow characteristics of the engine are calibrated, the display will show the fuel flow and fuel economy at each
speed.  

The THP/TkW and Vtas/Veas buttons at the bottom center are toggle buttons, and they allow you to switch the
display between thrust horsepower and thrust kilowatts, as well as between equivalent airspeed and true airspeed.
Remember, equivalent airspeed is indicated airspeed with no error.  

Caution.  The rate of climb will always be slightly excessive because at this time Benchmark does
not make an allowance for the decrease in propeller efficiency and increase in coefficient of drag that
occurs at high angles of attack.  

The minimum flying speed is not calculated, but may be added in the future.  The Best Climb text is editable.  The
purpose of this is to allow you to type another climb speed and to get the rate of climb, but that has not yet been
implemented.  

These curves deserve a word of explanation.  The aircraft will maintain level flight only at those speeds where the
power available equals the power required.  This occurs at the two points where the power required and power available
curves cross.  The lowest speed occurs on the back side of the power curve and normal cruise occurs at the higher speed
on the right side of the chart.  

The back side of the power curve is shown in a dramatic and easy-to-understand manner.  The difference between the
power available and the power required is the excess power which is available for climb—although a slight change in
propeller efficiency and aircraft drag will occur at high angles of attack requiring some additional flight tests before the
spread can be used for exact climb calculations.
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Miles Per Gallon Chart
Now that you have entered all of the data, analyzed all of the curves, you are ready to produce some aircraft performance
charts.  The most important of these—and the raison d’être of Benchmark—is the miles-per-gallon chart.  

The miles-per-gallon chart concept was originally developed for the B-29 bomber.  With that aircraft, it was imperative
that the flight engineer operate the aircraft for the greatest practical efficiency, which was no easy task when you
considered the large changes in aircraft weight, as well as other variables like winds and altitudes.  In fact, on the B-29,
the flight engineer was supplied with charts that showed the most efficient power settings for four-, three- and two-
engine operation.  These charts are extremely useful since they tell you at a glance for a given altitude which are the
most efficient power settings to use, how fast an aircraft will fly at various weights, the miles-per-gallon efficiency of
the aircraft, and a temperature correction chart for non-standard days.  

These charts were first introduced for general aviation aircraft by Mooney Aircraft in the early 1980s and proved to be
very popular with efficiency-conscious Mooney 201 pilots.  The development of these charts was done with largely
manual methods, using a series of look-up charts for this mathematically rigorous approach.  In a few hours with
Benchmark, you can duplicate the work that Mooney spent about $25,000.00 to accomplish—and with greater
accuracy.  

To produce a miles-per-gallon chart, you should first make a few selections.  

❏ Use the Font menu to choose the font you want to be used in the chart.  

❏ Choose Preferences in the Edit menu and select the units of measurement that you want in the miles-per-gallon
chart.  These include the units for speed, weight, temperature, fuel, altitude and manifold pressure.  You have complete
control over the units, and can produce charts in any combination of units—including kilometers per imperial gallons,
liters per nautical mile, or whatever turns you on.  

❏ In the File menu, choose Page Setup.  Select the method of ‘printing’ which means to select whether you want to
print direct on the Laserwriter, or whether you want to create an Adobe Illustrator file for editing, placement in a page
layout program like PageMaker or printing on a PostScript typesetter.  Also in the Page Setup dialog, select the line
weights to be used in the chart.  If you are going to print the chart eventually on a PostScript typesetter, it is very
important that you understand about hairlines—see “Hairlines and Your Sanity” under the Page Setup entry in
Chapter 10.  

❏ Finally, choose Miles Per Gallon from the Chart menu.  The following dialog box will appear:  

Miles-per-gallon charts are typically produced for two weights, the highest and lowest weights at which the aircraft
would be flown under normal circumstances.  The high gross weight would normally be the full gross weight of the
aircraft, while the low gross weight would be the weight of the aircraft with a single pilot and low fuel.  
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Benchmark can also present the miles-per-gallon chart information as Cafe 400 scoring, and the payload is used for
this.  The Cafe 400 scores are based on the same payload being used at the high gross weight as well as the low gross
weight.  

For most aircraft, the most efficient rpm is too low for practical operation because the propeller will hit the stops, so
you must specify the minimum rpm for the power schedule—2000 rpm is a good figure for many planes.  But if you
always cruise at 2400 rpm no matter what and want to have a chart that shows those engine speeds, then go ahead and
do it.  

Once you have selected the altitude, temperature (normally ISO standard), gross weights and minimum rpm, click on
the Calc button to cause the calculations to begin.  Benchmark begins with full throttle and maximum engine rpm for
the first calculation, and then steps down to 35% power in 5% intervals.  In each case it starts at the minimum rpm
and increases the rpm as required to get the desired percent power and also to select an rpm/manifold pressure
combination that does not exceed the maximum manifold pressure limit line.  

Note.  At this time, Benchmark assumes that this lowest-possible-under-the-circumstances rpm is
the most efficient in terms of miles per gallons.  For most aircraft, this is probably true, but to be
absolutely sure, Benchmark should calculate the next higher rpm and compare the miles-per-gallon
efficiency with the previous power setting.  This feature will be added (probably as a user-controlled
option) before Benchmark is released.  

After you click the Calc button, the calculated data points are displayed in the screen as shown above.  If the airplane
will not fly at the power setting, this will be shown in the display.  To print a copy of this data, click on the Print
button when the data is displayed.  

This dialog has three displays, which are controlled by the Plot Data which toggles through the three displays of Data,
MPG and Cafe 400.  

The miles-per-gallon chart that is drawn on the screen is a simplified version of the chart that is printed.  To print a
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chart, click on the print button.  

If you have printed a chart with two different weights, at each power setting, there is a diagonal line between the curve
for the high weight and the low weight.  For any weight between these two, you must approximate the location on
this diagonal line.  

At the bottom of the chart is a temperature correction chart.  This chart is based on the assumption that if the
temperature is non-standard, the pilot will increase or decrease the manifold pressure to maintain the percent power.
(Mooney, for example, adds this note to their chart,  “Note:  To maintain constant BHP at non-standard temperatures,
add 1” M.P. for each 10°C OAT above standard.  Subtract 1” M.P. for each 10°C OAT below standard.”)  The
temperature correction simply shows the increase or decrease in true airspeed for this temperature variation.  

As a practical matter, this minor adjustment may be of little use to the general aviation pilot because the change in
miles per gallon will be slight.  A simple method of handling this would be to print out a series of charts at
temperatures 10 and 20 degrees below and above standard, and then just use those charts.  

If you have created the chart in Adobe Illustrator format, you can manipulate it in many ways.  With Adobe Illustrator,
you can add notes to the chart, move things around and scale the entire chart up or down.  You can print the chart on
any PostScript printer or typesetter.  You can place the chart in Word 4.0 or PageMaker.  Of the two, PageMaker
handles this sort of image in a more intuitive manner, since you can see a preview of the image, can push and shove
the image around on the page, add a border and can scale the image.  

The chart can be imported into PowerDraw, DXF and other CAD formats by using PowerDraw Translator (Engineered
Software, P. O. Box 18344, Greensboro, NC 27419, telephone: 919-299-4843) for editing in PowerDraw, plotting on
a pen plotter, or transfer to many other graphics systems.  (The translator will also translate these CAD formats back
to Illustrator format.  That’s a remarkably useful capability, and we’re proud to say that we supplied much of the
programming that made this to/from Illustrator translation possible.)  

If you would like to see what this chart looks like in terms of Cafe 400 scores, click on the Plot MPG button and the
chart will change to the Cafe 400 chart.  When you click on the print button in this display, Benchmark will print the
chart that is shown.  
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In any of the three displays, you can change the wind speed, wind direction or payload.  Changes in the wind do not
change the shape of the miles-per-gallon curves (all of the numbers change), but these wind changes have a pronounced
effect on the shape of the Cafe 400 scores.  In the example above, for example, the airplane has a quartering tailwind of
30 mph at 150°.  

Benchmark
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Forms

Aircraft Data

Manufacturer:
Model:
Call Sign:Call Sign:
Wing Span (ft/m):
Wing Area (sq. ft/m2):
Gross Weight (Lbs/Kg):
Payload (Lbs/Kg):
Low Cruise Weight (lbs/Kg):
Number of Engines:

Manufacturer:

Number of Blades:
Blade Activity Factor:
Diameter (feet/centimeters):

Rotation (check one):      Single      Dual

Model:

Blade Thickness (check one):      Very Thin      Thin      Average      Thick      Very Thick

Propeller Data

Manufacturer:

Rated Power (bhp/kW):

Engine Data

Model:

Number of Cylinders: Bore (inches/mm):
Max RPM: Min RPM: Idle RPM:

Stroke (inches/mm):
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Appendix B
File Formats

File Type and Creator
Benchmark deals with four  files: airplane, engine, instrument and propeller files.  These files are text files and hold the
basic data.  

Macintosh files have two things that may be new to you, a Creator and a Type.  These two things keep programs from
trying to open a file that doesn’t belong to them.  All of these files will have the Creator of BHMK (for Benchmark).
The airplane files has a type of ARPL, the engine files has a type of ENGG, the instrument files have a type of INST
and the propeller file has a type of PROP.  Benchmark will only open files with these types.  If you want to work on
these text files, you have to change to file type to TEXT.  This can be done with any number of utility programs, but
the simplest method is to save the file as TEXT from within Benchmark—simply choose Save As and select the Text
option.  

General Comments
The Benchmark files are intentionally designed to be self-documenting and you will find most of this easy to read, but
you should be careful about changing something unless you know what you are doing.  

In many cases the information is presented on a line with the human-readable title, for example,

LinesofNotesFollowing: 1

is easy to understand, but you can royally screw things up for Benchmark if you mess with it.  The basic mechanism
here is that the first string of characters up to the first space are ignored by the program, but if you put any spaces in
it, like

Lines of Notes Following: 1

would cause the program to attempt to assign the string “of Notes Following: 1” to an integer variable and the
program would bomb.  So the first rule is not to put any spaces in any of the leaders.  

The second rule is to understand what you can change and what the rules are in every case.  Be aware that Benchmark
reads the files one line at a time and if you delete an expected line, everything will go to hell.  

Some of the files includes “Display...” items.  These are settings for how the program will show you the data.  You
can change these in the files or click on the various options in the Preferences dialog box.  The Display choices do not
change the file format, which is fixed.  So in the engine file, you may change DisplayPower to Kilowatts, but the data
in the file is always horsepower.  

In almost all cases Benchmark only looks at part of the word to determine what the user’s choice is.  In most cases this
is limited to the first character, but in other cases the parsing includes other characters.  The characters looked at by
Benchmark are underlined in the examples shown below.  Letters may be upper case or lower case, but no deviations
are allowed for numbers.  

Extended numbers are 80-bit real numbers.  From your standpoint, they are simply longer numbers.  

Benchmark Files
Airplane files include:

Standard file header
Airplane data block
Engine data block (if EngineInstalled: ‘Y’)
Propeller data block (if PropInstalled: ‘Y’)
Instrument data block (if AirspeedIndicatorInstalled: ‘Y’)
Instrument data block (if TachometerInstalled: ‘Y’)
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Instrument data block (if AltimeterInstalled= ‘Y’)
Instrument data block (if ManifoldPressGaugeInstalled= ‘Y’)

Propeller files include:
Standard file header
Propeller data block

Engine files include:
Standard file header
Engine data block

Instrument files include:
Standard file header
Instrument type block
Instrument data block

Standard File Header
All files contain the following header:

Benchmark Version: A string of characters (leave this alone)
Filename: This is the name of the file as you saved it.  It is ignored by Benchmark
FileType:     E    NGG (Engine),     P    ROP (Propeller),     A    RPL (Airplane),    I   NST (Instrument)

Warning.  The FileType is very important, and Benchmark must know this information to
determine how the read the rest of the file.  

If the FileType is an Airplane file, then there are additional lines for the header:

++RamRecoveryData(Y/N):     Y    ,     N    
++EngineInstalled(Y/N):     Y    ,     N
++PropInstalled(Y/N):     Y    ,     N
++AirspeedIndicatorInstalled(Y/N):     Y    ,     N
++TachometerInstalled(Y/N):     Y    ,     N
++AltimeterInstalled(Y/N):     Y    ,     N
++ManifoldPressGaugeInstalled(Y/N):     Y    ,     N

Instrument Type Block
InstrumentType:     Al   timeter,     Ai   rspeed Indicator,      M     anifold Pressure Gauge,     T    achometer

Instrument Data Block
Manufacturer: String[80]
Model: String[80]
SerialNumber : String[80]
NumberofPoints: integer from 0 to 20
(if NumberofPoints > 0 then...)
Indicated   Actual (Unit)               (where Unit = ft, mph, inHg or RPM.  This is just a header line)
real real (separated by white space)
. .
(number of lines must correspond with NumberofPoints)
. .
real real (separated by white space)

Propeller Data Block
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Manufacturer: String[80]
Model: String[80]
DisplayPropLength:    I   nches,     C    entimeters
Diameter(feet): real
BladeActivityFactor: real
NumberOfBlades: integer
Rotation:     S    ingle,     D    ual
BladeThickness(0..4):    0   ,    1   ,    2   ,    3   ,    4    (0 = VeryThin, 1 = Thin, 2 = Average, 3 = Thick, 4 = VeryThick)

Engine Data Block
Manufacturer: String[80]
Model: String[80]
DisplayPower:     H    orsepower,     K    ilowatts
DisplayBoreStroke:    I   nches,      M     illimeters
RatedHP: real
NumberCylinders: integer
MaxRPMs: real
MinRPMs: real
IdleRPMs: real
Bore(inches): real
Stroke(inches): real
ManifoldPressureLimit:                         (this is just a header line)
BHP1(hp): real
BHP2(hp): real
Map1(inHg): real
Map2(inHg): real  
A: real
B: real
NumberofPowerPoints: integer from 0 to 20
(if NumberofPowerPoints > 0 then...)
RPM  HPm MP1  HP1  MP2  HP2       (this is just a header line)
         hp     inHg  hp    inHg   hp         (this is just a header line)
real  real  real  real  real  real  (separated by white space)
. .
(number of lines of data must correspond to NumberofPowerPoints)
. .
real  real  real  real  real  real  (separated by white space)
HPmOrder: integer of -1 to 9, where -1 means ‘not calibrated’
HpmCoeffs:                                       (this is just a header line)
extended
. .
(number of lines corresponds to HPmOrder)
. .
extended
MpmOrder: integer of -1 to 9, where -1 means ‘not calibrated’
MpmCoeffs:                                       (this is just a header line)
extended
. .
(number of lines corresponds to MpmOrder)
. .
extended
FHPOrder: integer of -1 to 9, where -1 means ‘not calibrated’
FHPCoeffs:                                       (this is just a header line)
extended
. .
(number of lines corresponds to FHPOrder)
. .
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extended
NumberofFullRichFuelPoints: integer  from 0 to 50
(if NumberofFullRichFuelPoints > 0 then...)
BHP  GPH  RPM                               (this is just a header line)
real real real   (separated by white space)
. .
(number of lines must correspond with NumberofFullRichPoints)
. .
real real real   (separated by white space)
NumberofBestPowerFuelPoints: integer  from 0 to 50
(if NumberofBestPowerFuelPoints > 0 then...)
BHP  GPH  RPM                               (this is just a header line)
real real real   (separated by white space)
. .
(number of lines must correspond with NumberofBestPowerFuelPoints)
. .
real real real   (separated by white space)
BestPowerMaxPower(hp):  real   
NumberofBestEconomyFuelPoints: integer  from 0 to 50
(if NumberofBestEconomyFuelPoints > 0 then...)
BHP  GPH  RPM                               (this is just a header line)
real real real   (separated by white space)
. .
(number of lines must correspond with NumberofBestEconomyFuelPoints)
. .
real real real   (separated by white space)
BestEconomyMaxPower(hp): real
FullRichBHPOrder: integer from 0 to 10
FullRichRPMOrder: integer from 0 to 10
(if FullRichBHPOrder > 0 and FullRichRPMOrder > 0 then...)
FullRichCoeffs                                 (This is just a header line)
extended
. .
(number of lines must correspond with FullRichBHPOrder and FullRichRPMOrder)
. .
extended
BestPowerBHPOrder: integer from 0 to 10
BestPowerRPMOrder: integer from 0 to 10
(if BestPowerBHPOrder > 0 and BestPowerRPMOrder > 0 then...)
BestPowerCoeffs                                 (This is just a header line)
extended
. .
(number of lines must correspond with BestPowerBHPOrder and BestPowerRPMOrder)
. .
extended
BestEconomyBHPOrder: integer from 0 to 10
BestEconomyRPMOrder: integer from 0 to 10
(if BestEconomyBHPOrder > 0 and BestEconomyRPMOrder > 0 then...)
BestPowerCoeffs                                 (This is just a header line)
extended
. .
(number of lines must correspond with BestEconomyBHPOrder and BestEconomyRPMOrder)
. .
extended

Airplane Data Block
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Manufacturer: String[80]
Model: String[80]
CallSign: String[80]
DisplaySpeed:      M     PH,     Kt   s,     Km    h
DisplayTemp:     C    elsius,     F    arenheit,     K    elvin,     R    ankin
DisplayWeight:     L    bs,     K    ilograms
DisplayManifoldPressure:    I   nchesH   g   ,     B    ar
DisplayAltitude:      M     eters,     F    eet
DisplayFuel:     G    allons,     L    iters,    I   mpGallons
Font(0..6): integer
ChartBorderline: real
ChartDataline: real
ChartHairline: real
WingArea(sqft): real
WingSpan(ft): real
NumberofEngines: integer
MaxSpeed(mph): real
GrossWeight(lbs): real
LowCruiseWeight(lbs): real
Payload(lbs): real
Cdo(N/A_or_Number):     N    /A or real
OswaldEfficiencyFactor(N/A_or_Number):     N    /A or real
RamRecovery: real
RamPressAlt(ft): real
RamRPM: real
RamMAP(inHg): real
PitotStaticNbrPoints: integer from 0 to 20
(if PitotStaticNbrPoints > 0 then...)
ViasUncorr Vcas (mph)                         (this is just a header line)
real real   (separated by white space)
. .
(number of lines must correspond to PitotStaticNbrPoints)
. .
real real   (separated by white space)
PitotStaticOrder: integer from - 1 to 10 where -1 means ‘not calibrated’
(PitotStaticOrder > -1 then...)
PitotStaticCoeffs                                (this is just a header line)
extended
. .
(number of lines must correspond to PitotStaticOrder)
. .
extended
NumberofDragPolarFlightTests: integer from 0 to 20
(if NumberofDragPolarFlightTests > 0 then for 1 to NumberofDragPolarFlightTests...)
Drag Polar Data Block

Drag Polar Data Block
TestDate: String[80]
Pilot: String[80]
FlightEngineer: String[80]
CorrectforAdiabaticCompression(Y/N):     Y    ,     N
WeightatStartofRuns(Lbs): real
LinesofNotesFollowing: integer (but the notes are limited to 255 characters)
[ASCII characters]
[..]
(number of lines corresponds to LinesofNotesFollowing)
[..]
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[ASCII characters]
NumberofRuns: integer from 0 to 20
PressAlt  OAT   Vias   RPM   MAP   FuelFlow   FuelUsed   (this is just a header line)
ft           °C       mph             inhg    gal            gal            (this is just a header line)
real  real  real  real  real  real  real  (separated by white space)
. .
(number of lines corresponds to NumberofRuns)
. .
real  real  real  real  real  real  real  (separated by white space)
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Appendix A
Equations and Formulas

Most people glaze over when they see a formula, so we have intentionally kept the rest of the documentation free of
equations and formulas.  But if you are an engineer, physicist or just a sado-mathecist who wants to know how and
what we are doing inside Benchmark, this is the section for you.  

Atmospherics
Definitions
Pressure altitude = the altitude indicated by an altimeter when the altimeter is set at 29.92 inches of mercury.
Pressure altitude corr = corrected pressure altitude, the indicated pressure altitude corrected for instrument error.  
ISO standard sea level atmosphere temperature = 15°C, 288.16°K, 59°F or 518.688°R
ISO standard temperature lapse rate = 1.9811°C, 1.9811°K, 3.566°F or 3.566°R per 1000 feet
ISO standard sea level atmosphere pressure = 1 bar, 29.9213 in Hg, 14.696 psi, 706.7795 in H2O

Delta
“Delta” is the pressure ratio of the flight test altitude and sea level.  This is used to calculate density altitude and true
airspeed.  This ratio is represented by the greek letter δ, pronounced “delta”.  The formula for the pressure ratio is:

δ = P ÷ Po = (1 – 6.87535 x 10–6 x Hp)5.256

where: Hp = pressure altitude.
P = pressure at flight test altitude.
Po = pressure at sea level standard atmosphere.  

Benchmark uses the following function for Delta:

function Delta(PressAlt:real):real;
begin
  Delta := XpwrY(1 - 6.87535e-6 * PressAlt, 5.256)         
end;

Theta
“Theta” is the temperature ratio of the flight test altitude and sea level, calculated from absolute zero.  This is used to
calculate density altitude and true airspeed.  This ratio is represented by the greek letter θ, pronounced “theta”.  The
formula for the temperature ratio is:

θ = T ÷ To = (T + 273.16) ÷ 288.16 for °C
where: T = corrected OAT in °C .

To = temperature at ISO sea level standard atmosphere (15 °C).

Benchmark uses the following function for Theta:

function Theta(Temp:real):real;
begin
  Theta := (Temp + 273.16) / 288.16
end;
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Sigma
“Sigma” is the density ratio of the flight test altitude and sea level.  This is used to calculate density altitude, true
airspeed and in many other atmospheric calculations.  This ratio is represented by the greek letter σ , pronounced
“sigma”.  The formula for the density ratio is:

σ = δ ÷ θ
where: δ = Delta, the pressure ratio

θ = Theta, the temperature ratio

Benchmark uses the following function for Sigma:

function Sigma(PressAlt,Temp:real):real;
begin
  Sigma := Delta(PressAlt) / Theta(Temp)
end;

Standard Density Ratio
The density ratio for the ISO standard atmosphere (which does not account for any temperature deviations) is calculated
according to the following formula:

σstd = (1 – Hp/145350)4.25

where: Hp = pressure altitude in feet.

Benchmark uses the following function for ISO standard atmosphere density ratio:

function SigmaStandard(PressAlt:real):real;
begin
  SigmaStandard := XpwrY(1 - PressAlt / 145350,4.25)
end;

Density Altitude
The density altitude (Hd) in feet is calculated according to the following formula:

Hd = 145500(1 – σ.235)
where: σ  = δ ÷ θ (σ is “Sigma”, the density ratio)

Benchmark uses the following function for the density altitude:

function DensityAlt(Sigma:real):real;
begin
  DensityAlt := 145500 * (1 - XpwrY(Sigma, 0.235))
end;
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Speeds
Definitions
Vias or Vias uncorr = Indicated airspeed, not corrected for anything.
Vias corr = Indicated airspeed corrected for instrument error.
Vcas = Calibrated airspeed, is Vias corr for the pitot-static error.
Vtas = True airspeed.
Veas = Equivalent airspeed, indicated airspeed with no error, i.e. corrected for speed change due to compressibility.

Kts = Mph ÷ 1.15155
Mph = Kts * 1.15155

Equivalent Airspeed
Equivalent airspeed is indicated airspeed with no error and can be calculated from true airspeed by the following
formula:

Veas =Vtas * σ1/2

where: Veas = equivalent airspeed
Vtas = true airspeed
σ  = Sigma, the density ratio

Benchmark uses the following function for equivalent airspeed:

     function GetVeas(Vtas,Sigma:real):real;
     begin
       GetVeas := Vtas * sqrt(Sigma)
     end;

True Airspeed from Equivalent Airspeed
The formula for true airspeed is:

Vtas = Veas/σ1/2

where: Vtas = true airspeed
Veas = equivalent airspeed
σ  = Sigma, the density ratio

Benchmark uses the following function for true airspeed from calibrated airspeed:

function GetVtas(Veas,Sigma:real):real;
begin
  GetVtas := Veas / sqrt(Sigma)
end;
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True Airspeed from Calibrated Airspeed
This formula calculates true airspeed from calibrated airspeed:

(Vt = ao 5θ { δ
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where: Vt = true airspeed in mph
ao = speed of sound at ISO standard sea level = 761.13 mph
Vcas = calibrated airspeed in mph
θ = Theta, the temperature ratio
δ = Delta, the pressure ratio

Benchmark uses the following function for true airspeed from calibrated airspeed:

     function VcasToVtas(Vcas,Theta,Delta:real):real;
     const
       Ao = 761.13;
     var
       TAS : real;
     begin
       TAS := Ao * sqrt(5 * Theta * (XpwrY(((XpwrY((1 + 0.2 * sqr(Vcas / Ao)),
              3.5)) / Delta - 1 / Delta + 1),1 / 3.5) - 1));
       VcasToVtas := TAS
     end;

Speed of Sound
The speed of sound is a function of temperature only.  

(show formula)

Benchmark uses the following function for the speed of sound in mph from the temperature in °C (at absolute zero, the
computer will experience an error so an if statement is used):

     function SpeedofSound(Temp:real):real;
     begin
       if Temp <= -273.16
         then SpeedofSound := 0
         else SpeedofSound := 33.42 * sqrt(491.688 + 9 * Temp / 5)
     end;
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Dynamic Pressure

(show formula)

Benchmark uses the following function for to calculate the dynamic pressure Q in inches H2O from speed in mph:

     function MPHtoQ(Speed:real):real;
     var
       Po : real;                                      {pressure at sea level}
       Ao : real;                                {speed of sound at sea level}
     begin
       Po := 406.7795;                     {one atmosphere in inches of water}
       Ao := SpeedofSound(15.0);{at standard sea level atmosphere temperature}
       MPHtoQ := Po * (XpwrY(sqr(Speed / Ao) / 5 + 1,3.5) - 1)
     end;

Benchmark uses the following function to calculate the speed in mph from the dynamic pressure Q in inches H2O:

     function QtoMPH(Q:real): real;
     var
       Po : real;                                      {pressure at sea level}
       Ao : real;                                {speed of sound at sea level}
     begin
       Po := 406.7795;                     {one atmosphere in inches of water}
       Ao := SpeedofSound(15.0);{at standard sea level atmosphere temperature}
       QtoMPH := Ao * sqrt(5 * (XpwrY(Q/Po + 1,1 / 3.5) - 1))
     end;

Temperature Correction for Adiabatic Compression
One of the most bizarre concepts of aircraft performance analysis is temperature correction for adiabatic compression.
In order to convert indicated airspeed to true airspeed, you must know the outside air temperature, but—because of the
heating of air due to compression as it hits the OAT sensor and because of air friction against the OAT sensor—you
cannot know the outside air temperature unless you know how fast you are going.  

The problem is circular and can be solved by an interative solution.  Benchmark uses the following function to correct
the outside air temperature for adiabatic compression for a given true airspeed:

function OATcorrAC(OAT,Vtas:real): real;     {corrects OAT for adiabatic}
begin                         {compression for OAT in °C and Vtas in mph}
  OATcorrAC := OAT - (0.8336 * sqr(Vtas / 100));
end;

and then uses the following Pascal stub to calculate the outside air temperature:

ThisDelta := Delta(PressAlt);
OAT := OatUncorr;
for I := 1 to 5 do begin
  ThisTheta := Theta(OAT);
  Vtas := VcasToVtas(Vcas,ThisTheta,ThisDelta);
  OAT := OATcorrAC(OatUncorr,Vtas);
end;

Note that Theta is recalculated each time through the loop, but Delta is not.  The choice of 5 passes through the loop
is arbitrary and was selected by experimentation that showed that subsequent temperature changes were very small.  The
effects of this adjustment in temperature and the subsequent change in true airspeed can be seen by using Benchmark’s
atmospherics calculator.  



Benchmark

Propeller Efficiency

Blade Activity Factor
The Blade Activity Factor is a non-dimensional function which expresses the integrated capacity of the blade elements
to absorb power.  It is based on the fact that the ability with which a blade absorbs power is a function of the blade
area multiplied by the third power of the speed of the air passing over it.  The power-absorption ability of a blade
element is in turn proportional to the radius as measured from the axis of rotation.  An increase in blade width near the
propeller tip is relatively more effective for power absorption than an increase in width near the shank.  The blade
activity factor is similar to the aspect ratio of a wing, except that the tip of the propeller passes through the air faster
than the rest of the blade.  The Blade Activity Factor can be supplied by your propeller manufacturer.  Mathematically
it is calculated by the following expression:

∫
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where b = the blade width at a given r.
D = the propeller diameter.
R = the propeller radius.

The blade activity factors for the propellers used on the Sequoia F.8L Falco are:

HC-C2YL-1BF/F7663A-4 (72” diameter propeller for 150 and 160 hp): 103
HC-C2YK-1BF-F7666A-2 (74” diameter propeller for 180 hp): 105
HC-C2YK-1BF/F7666A-4 (72” diameter propeller for 180 hp): 112

The Total Activity Factor
The Total Activity Factor = Blade Activity Factor x Number of Blades.  

The Propeller Advance Ratio “J”
The Propeller Advance Ratio (J) is calculated from the formula from the Boeing General Propeller Chart, which is:

J = 88Vt ÷ ND
where: Vt = true airspeed in mph

N = propeller rpm
D = propeller diameter in feet

Benchmark uses the following function:

     function PropAdvanceRatio(Vtas,RPM:real):real;
     begin
       PropAdvanceRatio := (88 * Vtas)/( RPM * Prop.Dia)
     end;

The Coefficient of Power “Cp”
The Coefficient of Power (Cp) is calculated according to the following formula:

Cp = (BHPcorr ÷ 1000) ÷ [2σ(N ÷ 1000)3(D ÷ 10)5]
where: BHPcorr = corrected BHP

N = propeller rpm
D = propeller diameter in feet
σ  = Sigma, the density ratio
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Benchmark uses the following function to calculate the coefficient of power:

     function CoeffPower(BHP,RPM,Sigma:real):real;
     begin
       CoeffPower := (BHP / 1000)/(2 * Sigma * XpwrN(RPM / 1000,3)
                     * XpwrN(Prop.Dia/10,5));
     end;

The Power Adjustment Factor “X”
The power adjustment factor depends upon Total Activity Factor of the propeller and whether the propeller is single
rotation or dual rotation.  

     function PowerAdjFact: real;
     begin
       with Prop do
         case Rotation of
           SingleRot:PowerAdjFact := -0.08446 + 1.65/1094 * TotActFact;
           DualRot:  PowerAdjFact := -0.35032 + 22/8798.9 * TotActFact;
         end;
     end;

The Adjusted Coefficient of Power “Cpx”
The Adjusted Coefficient of Power (Cpx) is calculated according to the following formula:

Cpx = Cp ÷ x
where: Cp = Coefficient of Power

x = Power Adjustment Factor

“J/Cp^1/3”
The formula for J/Cp1/3 (pronounced as “jay over cee pee to the one third”) is:

J/Cp1/3 = J ÷ Cp1/3

where: J = Propeller Advance Ratio
Cp = Coefficient of Power

Propeller Efficiency “Eta”
“Eta” is the propeller efficiency and is represented by the greek letter η  (pronounced “eta”).  The Boeing General
Propeller Chart plots Eta vs J/Cp1/3 and Cpx.  The data is empirical and is not represented by a formula.  Benchmark
has a function:

     function Efficiency(J_CP,Cpx:real): real;

which computes propeller efficiency according to a series of multivariate polynomials.  
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Helical Tip Speed
The Helical Tip Speed (HTS) in feet/second of the propeller is calculated according to the following formula:

HTS = [(πND ÷ 60)2 + (5280Vt ÷ 3600)]1/2

where: N = propeller rpm
D = propeller diameter in feet
Vt = true airspeed in mph

Equivalent Helical Tip Speed
The Equivalent Helical Tip Speed (EHTS) in feet/second of the propeller is calculated according to the following
formula:

EHTS = HTS ÷ (a ÷ ao) = (HTS x ao) ÷ a
where: HTS = Helical Tip Speed

a = speed of sound at flight test altitude = 33.42T1/2 where T = °F + 459.688
ao = speed of sound at standard sea level = 33.42(518.688)1/2 = 761.13 mph

since: a ÷ ao = [33.42(491.688 + 9T/5)1/2] ÷ 33.42(518.688)1/2 = [(491.688 + 9T/5)1/2] ÷ (518.688)1/2

where: T = OATcorr  in °C
EHTS = [HTS x (518.688)1/2] ÷ [(491.688 + 9T/5)1/2]

Delta Eta Tip Speed
The change in propeller efficiency due to tip speed (∆ηt s) is only applied if the Equivalent Helical Tip Speed exceeds
1000 feet/second.  There are several formulas which are derived from a graph.  For a propeller of average width, the
formula is:

∆ηt s = .6 – .0006EHTS
where: EHTS = equivalent helical tip speed

“This loss of efficiency due to compressibility drag may be very severe for high-speed aircraft.  This correction is based
on an average of a large number of experimental tests.  The formulas used here may be conservative as the design of
special high-speed propellers is continually improving.  Little is known about the improvements in propeller
effieiencies that may be possible with swept-back blades, thin blade sections, and different propeller shank or root
shapes.”—Airplane Performance, Stability and Control, by Bob Hayes and Curt Perkins, John Wiley

Benchmark used the following function to compute ∆Eta TS:

     function DeltaEtaTS(RPM,Vtas,Oat:real): real;
     var
       HTS  : real;                     {helical tip speed: feet per second}
       EHTS : real;          {equivalent helical tip speed: feet per second}
     begin
       HTS := sqrt(sqr(Pi * RPM/60 * Prop.Dia) + (5280 * Vtas/3600));
       EHTS := (HTS * sqrt(518.688)) / sqrt(491.688 + (9/5 * Oat));
       if EHTS < 1000
         then DeltaEtaTS := 0.0
         else case Prop.BladeThick of
                VeryThin  : DeltaEtaTS := 0.48 - (0.00048 * EHTS);
                Thin      : DeltaEtaTS := 0.53 - (0.00053 * EHTS);
                Average   : DeltaEtaTS := 0.60 - (0.00060 * EHTS);
                Thick     : DeltaEtaTS := 0.67 - (0.00067 * EHTS);
                VeryThick : DeltaEtaTS := 0.75 - (0.00075 * EHTS);
              end;
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Delta Eta Total Activity Factor
Propeller efficiency requires an adjustment for the Total Activity Factor.  For Total Activity Factors below 750, the
following formula is used:

∆ηtaf = –.005 x (.188 x TAF/300 – .282) x (J/Cp1/3)3
where: TAF = Total Activity Factor

For Total Activity Factors above 750, a third-order polynomial is used to duplicate a curve.  Combining these,
Benchmark uses the following function :

function DeltaEtaTAF(J_Cp:real): real;
const
  A = -1.255451798439025879;
  B = 3.8094355259090662e-3;
  C = -3.238649924242054112e-6;
  D = 9.683936985638297301e-10;
var
  TAF2,TAF3 : extended;
begin
  with Prop do
    if TotActFact <= 750
      then DeltaEtaTAF := -0.005 * (0.188 * TotActFact/300 - 0.282)*J_Cp
      else begin
        TAF2 := TotActFact * TotActFact;
        TAF3 := TAF2 * TotActFact;

          DeltaEtaTAF := -0.005*(A + B*TotActFact + C*TAF2 + D*TAF3)*J_Cp;
      end;
end;

Corrected Propeller Efficiency “Eta Corrected”
The Corrected Propeller Efficiency (ηcorr) is calculated according to the following formula:

ηcorr = η + ∆ηts + ∆ηtaf
where: η = propeller efficiency

∆ηt s = change in propeller efficiency due to tip speed
∆ηtaf = change in propeller efficiency due to Total Activity Factor

Propeller Efficiency Limitations
We would like all users of Benchmark to understand the limitations of the propeller efficiency calculations used in
Benchmark.  

First, we know absolutely nothing about propeller efficiency.  All of the calculations in Benchmark are derived from
the Boeing General Propeller Chart and the method developed by Edmund Allen and his team of engineers.  One of the
engineers from that original team, Fen Taylor, served as our consultant and supplied all of the engineering
methodology used in Benchmark.  Fen and Dorothy Taylor—both are aeronautical engineers—are specialists in aircraft
performance testing and analysis, did the performance testing on a number of aircraft for Mooney and other companies,
and are widely recognized as experts in this field.  They assure us that this method is extremely accurate.  We believe
them, but we want you to know that we are taking this on faith and that we have no first-hand knowledge of actual
propeller efficiency.  

Second, the Boeing General Propeller Chart was drawn by hand as a chart of Eta vs J/Cp^1/3 with lines representing
various values of Cpx.  When we plotted the data represented by these charts against Cpx for various values of
J/Cp^1/3, the curves were not always smooth, and to make them smooth, we fudged the data for those lines.  The
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amount of change was extremely small (most are less than a tenth of a percent) and that’s less than a pencil-line width
on the original chart.  We don’t regard the changes as significant, but we want you to know that we fudged the data
slightly.  

Third, the Boeing General Propeller Chart does not predict propeller efficiency for the full range of Cpx and J/Cp^1/3,
but only shows those areas depicted above in white.  So that Benchmark would be able to calculate propeller efficiency
at the full range of values, we extended the curves.  You can see what we have done by using the propeller efficiency
calculator, because the “fictional” efficiencies are represented by a gray line.  

This is not as bad as it sounds.  It is obvious to anyone who thinks about it that at a Cpx of 0, the efficiency must
also be 0, no matter what the J/Cp^1/3, because if you are putting no power into the blades, the propeller cannot
produce any power and thus the efficiency is also 0.  It is probably a physical impossibility to fly an airplane at very
low values of Cpx and even if it did, then it would fly at relatively low speeds.  At very high values of Cpx and
J/Cp^1/3, the curves are very gradual and our approximations are probably quite reasonable—but again, actual operation
of an aircraft in such a realm would be possible only if the designer of the aircraft had escaped from a mental institution
and had made the most egregiously poor choice of propeller for the airplane.  

The important thing to remember is that this mathematically rigorous method is capable of producing nonsensical
answers at times.  Always remember that the calculations produced by Benchmark are not reality.  Your airplane is
reality, and it is essential that you confirm the accuracy of Benchmark’s performance predictions before you depend on
them.  

Engine Power                                                                                                                 
The calculation of engine power in Benchmark is done by a rather complicated formula developed for us by James S.
Petty, of Dayton, Ohio.  The formula duplicates the sea level and altitude engine performance charts used by engine
manufacturers.  In order to understand the Petty Engine Power Equation, you need to understand the methods used to
construct the charts, the assumptions behind those charts and the physics involved.  

Whoopee Dept.  Although Jim shrugs it off as “easy”, it should be noted that—as far as we
know—the engine performance charts have heretofore never been solved as an equation.  And all
engineers that have looked at this equation have confirmed that it is the same thing as the standard
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sea level and altitude engine performance chart.  All this is a blessing to mankind, because those
charts are notoriously difficult to use.  

The method used to construct engine performance charts is described in Aircraft Power Plants by A. P. Fraas (who
includes a number of errors), and in Pierce, S.A.E. Trans., vol. 35, 1940.

Typically, an engine manufacturer will only run a few dozen calibration points at sea level.  These are used to define a
complete set of curves for that engine.  Engine performance charts are based on the following assumptions:

For the relation between power and manifold pressure, engine power output at a particular speed with a constant
induction air inlet temperature is directly proportional to the intake manifold air pressure.  Thus, the constant rpm lines
are straight lines on a chart of manifold pressure vs horsepower.  

Fraas Boo-Boo No. 1.  Fraas states that a large amount of experimental data indicates that
these straight lines are not parallel but intersect at a point of zero manifold pressure and a particular
minus horsepower value—known as FHP or Friction Horsepower—which is characteristic of the
engine and which is determined empirically from the test data points.  

This is absurd for two obvious reasons.  First, the FHP must be 0 at 0 rpm.  Second, the FHP of
the engine must vary with the speed of the engine.  These conditions make it impossible for the
lines to intersect at a single point.  

This brings up an interesting point.  As you will find when you fit curves to the data taken from
your engine manufacturer’s sea level performance chart, the curve from friction horsepower often is
illogical and curves in the wrong direction.  The answer, we suspect, is that (1) the engine
manufacturer did not have any ready tools like Benchmark to easily plot the friction horsepower
and (2) that the draftsman drawing the chart probably noticed that the lines appeared to cross at
approximately the same position and thus allowed this perception to influence the way the lines
were drawn.  

The friction horsepower (FHP) at each rpm is determined by extending the lines of constant rpm to calculate the
“horsepower” of the engine at 0 manifold pressure.  The FHP curve does not obey a rigid formula, and a curve-fitting
method must be used to approximate it.  

The maximum power at each rpm (BHPm ) depends on the volumetric efficiency of the engine and is determined from
the test data points.  Volumetric efficiency is largely a function of engine rpm.  With a normally aspirated engine, the
maximum attainable manifold pressure decreases with engine speed, however it increases with engine speed for
supercharged and turbocharged engines.  In all cases, the maximum-power line is curved.  This curve does not obey a
rigid formula, and a curve-fitting method must be used to approximate it.  

Just as the maximum power varies with rpm, so does the maximum manifold pressure (MAPm ).  This curve does not
obey a rigid formula, and a curve-fitting method must be used to approximate it.  

The value Rm is the ratio of the manifold pressure (MAP) with the maximum manifold pressure (MAPm ) for that
RPM.    Note that maximum power (BHPm ) occurs at a value of Rm = 1, and that at Rm = 0, the formula for BHPSL
returns FHP for that RPM.  

It has been found that the engine power capacity at a constant RPM varies linearly with the altitude-density ratio, and
that it drops to zero at an altitude density ratio of approximately 0.117, i. e., at an altitude of 55,400 ft.  This relation
holds within the limits of experimental error for all types of engines regardless of combustion-chamber form, cylinder
arrangement, compression ratio or supercharger gear ratio.  

The basic relationships between the manifold pressure, RPM and altitude are shown on the engine performance chart.
In the sea level chart, BHP is plotted against manifold pressure.  In the altitude chart, horsepower is plotted against the
density ratio, thus on the horizontal axis the density ratio begins with 1.0 and then decreases in even increments (1.0,
.9, .8, .7, ..., .1) to the right.  While the chart is plotted in the density ratio, the values are normally given as the
corresponding altitude.  
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On the sea level chart, the lines of constant RPM end at the maximum available manifold pressure and BHP.  These
maximum power points are used on the altitude chart at sea level.  Thus, on the left side, the lines end at a curved line
of maximum power, while on the right side the lines radiate from the common focal point (zero BHP and 0.117
density ratio) to the vertical line representing sea level altitude.  The left lines end in a curve, the right lines end on a
straight line.  

A set of curved lines drawn through points of constant full-throttle manifold pressure is given on the altitude portion of
the chart.  These curves occur as a result of the relationships of the lines on the sea level portion of the chart.
Although horsepower is a linear function of the density ratio, the manifold pressure is a linear function of the pressure
ratio.  

Historical Fiction.  Fraas states that it has been found that the constant-speed-constant-
manifold-pressure lines all have a common slope which can be obtained from the negative
horsepower value FHP on the sea level side of the chart.  This is incorrect, since (a) FHP is not a
fixed figure for all RPMs, (b) it is logical that the manifold pressure be a function of the pressure
ratio and not the density ratio, and (c) formulas so constructed do not match the charts issued by
Lycoming engines we have studied.

The Petty Engine Power Equation is:

BHPcorr t

1

1
m

.117
.883

.81
mR

= BHP C mR[ – fR ( 1 – mR )] σstd – .81
mR( ) + ( – )( )– σstd

– .81
mR

where: Ct = [(288.16 – 1.98111Hp/1000)/(273.16 + T)]1/2 = temperature correction factor for °C.
Ct = [(518.688 – 3.566Hp/1000)/(459.688 + T)]1/2 = temperature correction factor for °F.
Rm = MAP/MAPm = manifold pressure ratio.
Rf = FHP/BHPm = friction horsepower ratio (a positive value).
σstd = (1 – Hp/145350)4.25 = density ratio for standard atmosphere.
Hp = pressure altitude in feet.
T = outside air temperature in °C or °F at altitude H.
MAP = manifold pressure in inches of Mercury.
BHPm = maximum sea level BHP for the RPM—typically a polynomial.
MAPm= maximum sea level manifold pressure for the RPM—typically a polynomial.
FHP = friction horsepower for the RPM—typically a polynomial.  FHP is BHP at MAP = 0.
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Derivation of the Petty Engine Power Equation
As the Petty equation is new, we are including here a derivation of the equation.  

FHP MAP MAPm 0.117

altitude = H

ALTITUDESEA LEVEL

a

DENSITY RATIO1.0

BHP vs Altitude
at constant MAP

Limit BHP vs Altitude locus

BHPm

BHP vs MAP

A stylized engine performance chart for a single RPM is shown above.  The sea level curve is a straight line rising
from a characteristic negative power FHP at zero MAP to a maximum power BHPm at a maximum manifold pressure
MAPm.  

On the altitude side of the chart is shown a representative BHP vs Altitude line for a constant MAP.  This line is a
linear function of the altitude density ratio, rising from the sea level BHP to a limit beyond which the MAP cannot be
maintained.  The locus of these limit points for different MAPs at constant RPM define a limiting BHP vs Altitude
line for each RPM.  This limit BHP vs Altitude curve is a linear function of the altitude density ratio, starting at
BHPm at a density ratio of 1.0 and decreasing linearly to zero at a density ratio of 0.117.  

It is reasonable to suppose that, for a particular MAP, the limit altitude will be determined by ambient pressure—that
is, for an unsupercharged engine, the manifold pressure can’t be greater than the ambient static pressure (or for a ram
induction system, the total pressure).  This means that MAPa should be a linear function of Pa, the pressure at a.  

The following two sections contain the development of the power chart equations from the above description.  

The Sea Level Curve.  The sea level side of the performance chart is properly represented by straight lines of BHP
vs MAP for each RPM.  The equation for these straight lines is:

BHPSL = BHPm x [Rm – Rf(1 – Rm)] [Eqn 1]

—or—

          
MAPSL

BHPMAPm=
( )+ FHP

BHPm + FHP

where: Rf = FHP ÷ BHPm = the friction horsepower ratio.
Rm = MAP ÷ MAPm = the manifold pressure ratio.
BHPm = maximum horsepower as a function of RPM.  
MAPm =  maximum manifold pressure as a function of RPM.  
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FHP = the friction horsepower at zero manifold pressure as a function of RPM.

Note: BHPm, MAPm and FHP must be determined from the engine performance chart.

The Altitude Curve.  The altitude side of the performance chart is represented by straight lines of BHP vs density
ratio for each RPM:

(a
– 0.117
0.883BHPm=BHP

σa )
where: σa = the density ratio at point a.  

For each RPM the manifold pressure varies linearly with the pressure ratio:

[Eqn 2]a
Pa
PSL

xMAPm=MAP

The density ratio is given by

σa = ρa/ρSL = (1 – Ha/145350)4.25 = the density ratio of the standard atmosphere at point a.

where: Ha = the altitude in feet at the point a.  

Now since

P = ρ x R x T

where: R = the gas constant,

and since

Ta/TSL = 1 – Ha/145350 [Eqn 3]

then

Pa/PSL = MAPa/MAPm = (1 – Ha/145350)5.25 = ρa/ρSL5.25/4.25 = σa5.25/4.25

and, therefore,

σa = ρa/ρSL = (MAPa/MAPm)0.81

Since we are following a constant manifold pressure line

MAPa = MAP
MAPa/MAPm = MAP/MAPm = Rm, thus
σa = Rm0.81 [Eqn 4]

Substituting this into the equation of BHPa gives:

BHP a (BHPm )– 0.117
0.883

= [Eqn 5]m
0.81

R

The constant manifold pressure line on the altitude chart has the slope
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σa

BHP a – BHP
SL

1 –

so that the BHP (uncorrected for temperature) at the altitude H is given by

( )σstdσa1 –
[Eqn 6]BHPunc

= BHP
SL

+
BHP a – BHP

SL x 1 – )(

which can be rearranged to give

( )BHPunc
= x BHP

SL
+ x BHPa

σstd – σa )(
σa1 –

1 – σstd
σa1 – )(

where: σstd = (1 – Hp/145350)4.25 = the density ratio for the standard atmosphere.  

Substituting Rm0.81 for σa per Equation 4, Equation 6 can now be written as either

BHPSLBHPunc
= + 1 – σstdBHPa 1 – Rm

0.81– BHPSL( ) [Eqn 7a]

[Eqn 7b]
BHPSLBHPunc

=
σstd – Rm

0.81( ) + (1 – σstd )BHPa
1 – Rm

0.81

with: BHPSL = BHPm x [Rm – Rf(1 – Rm)] (which is Equation 1)
BHPa = BHPm x [(Rm0.81 – 0.117) ÷ 0.883] (which is Equation 5)

The corrected BHP is obtained by multiplying by a temperature correction factor

[Eqn 8]BHPcorr ( )= BHPunc
459.688 + Tstd
459.688 + TH

1/2

where: Tstd = 59 – 3.566Hp/1000 for °F
TH = outside air temperature at altitude H, in °F

Equation 8 with Equations 7a or 7b describe the engine performance chart.  
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Benchmark uses the following function to calculate engine power:

function GetBHP(MAP,ThisRPM,PressAlt,Oat:real):real;
var     
  SigS  : real;                         {density ratio of std atmosphere}
  BHPm  : extended;     {maximum attainable hp at sea level for that RPM}
  FHP   : extended;                                 {friction horsepower}

   Rm    : extended;                             {manifold pressure ratio}
   RmR   : extended;                                             {Rm^0.81}
   Rf    : extended;                           {friction horsepower ratio}

  Ct    : extended;                       {temperature correction factor}
  BHPSL : extended;                                       {BHP sea level}
  BHPa  : extended;                                     {BHP at altitude}
begin
  BHPm := Polynomial(HPmCoeffs,HPmOrder,ThisRPM);
  FHP := Polynomial(FHPCoeffs,FHPOrder,ThisRPM);
  Rf := abs(FHP / BHPm);
  Rm := MAP / Polynomial(MPmCoeffs,MPmOrder,ThisRPM);
  Ct := sqrt((288.16 - 1.98111 * PressAlt / 1000) / (273.16 + Oat));
  BHPSL := BHPm  * (Rm - Rf * (1 - Rm));
  if PressAlt = 0
    then
      GetBHP := BHPSL * Ct
    else begin
      SigS := SigmaStandard(PressAlt);      
      RmR := XpwrY(Rm,0.81);
      BHPa := BHPm * ((RmR - 0.117) / 0.883);
      if (BHPa - BHPSL) > 0
        then BHPa := BHPSL + ((BHPa - BHPSL) * ((1 - SigS) /(1 - RmR)));
      GetBHP := BHPa * Ct;
    end;
end;

Engine Power Calculation Limitations
We want you to understand the limitations of representing the power of an engine with a computer.  As with so much
else, the old garbage-in-garbage-out axiom applies.  

First, the engine manufacturer’s sea level and altitude performance charts do not account for the installation of the
engine.  Because of the induction system, exhaust system, engine cooling, variations in individual engines, the age of
the engine and many other factors, you can be assured that the actual horsepower developed by your engine will vary
from that calculated by the formulas.  

The Petty Engine Power Equation will predict power output well outside the engine capability if “inappropriate”
numbers are entered, such as excessive rpm and excessive manifold pressures.  The equation will predict engine power
in the non-operational range above the limiting manifold pressure for continuous operation, and it will predict engine
power at unattainable manifold pressures—at 120 inches of manifold pressure your engine will explode, but the
equation will not.  

The good news is that the equation is still useful in calculating the relative changes in power with manifold pressure,
RPM, pressure altitude and temperature, and thus is useful in calculating the performance of the airplane from flight
tests.  While your engine may develop less—or more—power than calculated, most of this will come out “in the
wash” as an artificially high—or low—coefficient of drag, and the equation will give a consistent variation with
changes in manifold pressure, RPM, pressure altitude and temperature.  Without accurate torquemeter readings on your
airplane, the engine manufacturer’s performance chart is the most reasonable basis for calculating the performance of
the engine, and this method is much more accurate that attempting to read the chart for every number.  
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The accuracy with which the equation duplicates published charts depends upon two principal factors: the accuracy with
which you note the BHPm, MAPm and FHP—the charts can be difficult to read, since the grid lines are frequently
unevenly spaced—and the accuracy with which the polynomial curve-fitting formulas reproduce those values.  

It is not clear if the engine power equation will accurately predict the performance of a supercharged or turbocharged
engine at altitude.  Since the primary difference is in the curve of the maximum manifold pressure and maximum
engine power, we believe it will, but at this time we have not tested the equation to make sure.  

The power curves published by engine manufacturers are normally for an engine leaned to best power mixture, thus the
engine power calculations produced by Benchmark are slightly excessive for full rich and best economy mixture
settings because the engine will produce less power at those mixture settings.  

Finally, neither the engine power equation, propeller efficiency function, nor any of the standard aerodynamic
calculations (for lift, drag, etc.) take humidity into account and humidity can have a profound effect on the aircraft’s
performance.  

As always, remember that the calculations produced by Benchmark are not reality.  Your airplane is reality, and it is
essential that you confirm the accuracy of Benchmark’s performance predictions before you depend on them.  

Limiting Manifold Pressure for Continuous Operation
Many engine sea level charts have a straight line called “limiting manifold pressure for continuous operation” as shown
below.

limiting manifold pressure
for continuous operation

In Benchmark, we simply treat the limit as a linear relationship between manifold pressure and engine power:

BHPLimit = A + (B * MAP)

—or—

MAPLimit = (BHP – A) ÷ B

where: BHP = horsepower.
MAP = manifold pressure in inches Hg.    

These equations may be combined with the equations for the sea level chart to provide for the direct calculation of the
BHPLimit as a function of RPM:

BHPLimit
BHPm + FHP

MAPm FHPx A

B
+

1

B
–

BHPm + FHP

MAPm
=



Benchmark

Or MAPLimit as a function of RPM:

MAPLimit
+ FHPA

B–
BHPm + FHP

MAPm

= ( )
Power Schedules
In a Lycoming report “Development of Power Charts for Avco Lycoming Normally Aspirated Aircraft Engines”, dated
October 20, 1980, the author David R. Clark describes a method of developing power charts that airframe
manufacturers include as part of their flight manuals and to aid the manufacturer in the determination of performance
and power settings.  The method is also used to determine the required manifold pressure to produce a given horsepower
at a specific altitude.  This information is often required for flight test data, or as an aid to a pilot desiring to operate at
a specific power condition.  

The method described by Clark is based on a graphical method of interpreting the sea level/altitude performance chart.
As a practical matter, this can be easily done with Benchmark’s engine power calculator, but as a matter of interest, we
are including here a condensed verion of the Clark report along with the pertinent parts of the Petty Engine Power
Equation that can be used to duplicate the graphical method.

The procedure is:

1.  Select the desired horsepower and engine speed.  

2.  Determine the required manifold pressure at this desired horsepower and engine speed at sea level from the sea level
side of the specification power curve.

This can determined by solving the equation for the sea level side of the performance chart (Eqn 1) for MAP, thus

MAPSL
BHPMAPm=
( )+ FHP

BHPm + FHP

3. Determine the manifold pressure and altitude where the full throttle power line intersects the desired horsepower and
engine speed on the altitude performance side of the specification curve.

The manifold pressure of the critical altitude can be determined by solving the equation for the performance chart for the
density ratio of the critical altitude, thus

BHP= BHPm
+caσ

.883 .117

and at standard temperatures, the altitude in feet of the critical altitude can be determined by

Hca = 145350(1 – σca.236)

and the manifold pressure in inches Hg at the critical altitude can be determined by

MAPca = 29.92σca
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MAPSL

0

∆MAP

Ha Hca

MAPca

MAPa

Altitude

∆H

4.  On a separate curve:  Locate the points determined in steps 2 and 3 (manifold pressure and altitudes) on a curve of
manifold pressure (In. Hg) versus altitude (Ft.).  Connect the two points located on the manifold pressure vs altitude
curve with a straight line.  See illustration above.

5.  Using the manifold pressure vs altitude curve developed in step 4, the manifold pressure for the desired horsepower
and engine speed can be determined from this curve at any altitude between sea level and full throttle altitude.  

The manifold pressure at any altitude can be determined by the formula

MAPSL ∆MAPMAPa = –

—or—

MAPSL
Ha

Hca

MAPca
MAPa = –

( )MAPSL –

Aerodynamics
Drag
The drag of the airplane is calculated using the following formula:

D = (375 x THPa) ÷ Vt
where: D = drag in lbs

THPa = thrust horsepower available
Vt = true airspeed in mph

Coefficient of Drag
The coefficient of drag (Cd) is calculated using the following formula:

Cd = (391 x D) ÷ (S x Veas2)
where: D = drag in lbs

S = wing area in square feet
Veas = equivalent airspeed in mph
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Coefficient of Lift
The coefficient of lift (CL) is calculated using the following formula:

CL = (391 x W) ÷ (S x Veas2)
where: W = gross weight in lbs

S = wing area in square feet
Veas = equivalent airspeed in mph

Drag Polar Data Reduction and Analysis
The drag polar flight test data is analyzed in a mathematically rigorous method described here to obtain the coefficient
of drag (Cd) and the coefficient of lift (CL) of the aircraft at each point, and from these are calculated the profile drag
coefficient (Cdo) and the Oswald efficiency factor (E).  

The formula for the coefficient of drag:

Cd = Cdo + Cdi
where: Cd = coefficient of drag for the airplane (this varies with speed and weight)

Cdo = profile drag coefficient (a constant)
Cdi = induced drag coefficient (this varies with the lift)

The profile drag measures the drag of the airplane at zero lift.  This is a fixed value.  The induced drag is the drag due to
lift.  When you are heavy, slow, or both, the wing has to get more lift out of the air, and the drag goes up.  The
formula for the induced drag coefficient is:

Cdi = CL2/πARE
where: CL = coefficient of lift

AR = aspect ratio =  wing span2 ÷ wing area
E = Oswald Efficiency Factor

According to the Prandtl wing theory, Cdi = CL2/πAR, but all of Prandtl’s work was on elliptical wings, and it was
soon discovered that the formula did not work on other types of wings.  Thus, the Oswald efficiency factor makes an
adjustment for “less perfect” wings.  Of all the variables in this formula, only the Oswald efficiency factor is unknown.
Combining the two formulas, we now get:

Cd = Cdo + CL2/πARE

This happens to be a parabola, but by plotting Cd vs CL2, the parabola turns into a straight line—which is much more
useful.  The straight line passes through Cdo at the point where CL = 0.  In Benchmark, this is handled by doing a
linear regression “curve-fit” on the data of Cd and CL2

to arrive at the coefficients A and B in:

CL2 = A + BCd

And then solving for Cdo and Oswald E with:

Cdo = -A / B
E = B / πAR
where: AR = aspect ratio =  wing span2 ÷ wing area
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Chapter 10
Benchmark Reference

Standard Benchmark Data Edit Dialog Box
At many places in Benchmark, you will encounter a dialog box like the one shown below.  

While the number of columns will vary—as will the names of the columns—the operation is always the same.  You
type the information required in the data entry box of the Edit bar, shown below.  

Cancel box.  Click here to cancel an 
entry or to delete a row.

Enter box.  Click here to enter  the data.

Column heading.

Data entry box.
Unit of measurement.

You have several options available to move about the data.  Press the Tab key to accept the data and move to the next
cell on the right.  When you are entering data, the Tab key will automatically create a new row when you get to the
last cell on the right.  At other times, the Tab key will not create a new row, but will move to the next row, and then
when you reach the last cell, it will move to the first cell.  

To enter the text into the cell without moving to another cell, press the Enter key or click on the Enter box in the Edit
bar.  

If you enter text into the data entry box and then click on another cell, the data will be entered into that cell before
moving to the next cell.  

To create a new row, press the Return key.  The new row will be inserted after the row that the currently selected cell is
in.  To delete a row, select the row number on the left by clicking on it, and then click on the Cancel box in the Edit
bar.  

When you click on the OK button, the data in the data entry box will be entered into the cell before the dialog box is
dismissed.  
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File Menu
The File menu consists of Benchmark commands which permit creating, loading, saving and closing files.  In addition,
this menu contains page setup and printing options.  Finally, the File menu permits you to quit Benchmark.

New...
New creates a new Benchmark document.  

To create a new Benchmark document:
❏ Choose New from the File menu.  The following dialog box will appear:

❏ Select the file type that you want to create.  Each of the selections leads to a series of other dialog boxes which 
ask for additional information.  

If you select Aircraft, the following dialog box will appear:

Type the information required.  The low cruise weight is the lowest weight at which you would normally cruise
(empty weight + pilot weight + low fuel weight) and is used in the miles-per-gallon charts.  The payload is for Cafe
400 scoring.  

If you select Engine, the following dialog boxes will appear:

Type the information required, then after you click on OK, the following dialog box will appear:
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Type the engine power data points, then click on OK.  See “Power Data” on page 10-10 for an explanation of this data.

If you select Propeller, the following dialog box will appear:

Type the propeller manufacturer name, model number or name, and propeller diameter.  If the diameter is not in the
unit of measurement that you want, change it with the Inches/Centimeters popup.  

Dual rotation propellers are exceedingly rare and haven’t been used in piston-engine aircraft since just after WWII, but
Benchmark has the ability to calculate the efficiency of such a propeller.  

The blade activity factor (described more fully in Appendix A) is very much like the aspect ratio of a wing, but because
the tip of the propeller travels through air faster than the rest of the blade, some adjustment must be made for this.
The propeller manufacturer can supply this information.  

The blade thickness applies only if the EHTS (equivalent helical tip speed—see Appendix A) goes over 1000 ft/second.
Unless you know that your propeller tip will be operating at those speeds, it is best to leave Blade Thickness set to
Average.  

If you select Instrument, the following dialog box will appear:

Type the information required.  
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Open...
Open presents you with a dialog box which allows you to open four types of documents.  

To open a Benchmark document,
❏ Choose Open from the File menu.  The following dialog box will appear:

❏ Select the file and file type you want to open.  

Benchmark document files are ordinary text files in which the data is stored in a rigid format.  To prevent you from
opening the wrong file at the wrong time, these files are assigned special Finder Types.  To allow you to examine or
change the files and then open them with Benchmark, the Text option is provided.  This allows you to open any text
file; however, the file must be exactly as required for a Benchmark aircraft, engine, propeller or instrument file or a
system error will result, and the computer will crash.  Use great care in using the Text option.  

Close
Closes the current file and eliminates it from the computer memory.  

Save
Saves the current file.

Save As...
Saves the current file under a new name.  When you choose Save As from the File menu, the following dialog box
will appear:

Benchmark document files are ordinary text files in which the data is stored in a rigid format.  To prevent you from
opening the wrong file at the wrong time, these files are assigned special Finder Types.  To allow you to examine or
change the files, the Text option is provided.  

Install Engine...
Opens an engine file and installs it in the airplane file.  This command is available only when you have an airplane file
open.  
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Benchmark operates on the concept of ‘installing’ engine, propeller and instruments into an airplane.  In reality, what
occurs is that you bring the data from those files and put it in the airplane file where all of the data is stored together.
Once you install the files, you must still save the airplane file or the information is lost.  Benchmark does not store
any information to disk unless specifically instructed to do so with a Save command.

Install Propeller...
Opens a propeller file and installs it in the airplane file.  This command is available only when you have an airplane
file open.  

Install Instrument...
Opens an instrument file and installs it in the airplane file.  This command is available only when you have an
airplane file open.  

Export Engine...
Export Propeller...
Export Altimeter...
Export Tachometer...
Export Airspeed Indicator...
Export Manifold Pressure Gauge...
Allows you to save these portions of an airplane file as a separate file.  These commands are available only when you
have an airplane file open.  

Page Setup...
Brings up the following dialog box:

Benchmark uses a special PostScript printer driver and can ‘print’ charts in three ways, direct to a LaserWriter (or other
PostScript printers), or it will create a file on disk in Adobe Illustrator format.  You can open the chart with Adobe
Illustrator and edit it.  Charts in Adobe Illustrator can be placed in PageMaker or Microsoft Word 4.0 documents and
can be imported into PowerDraw 3.0 for editing.  

If you do not have Adobe Illustrator and want to create a chart for printing at a later time, select SendPS file.  A
SendPS file is also an Adobe Illustrator file but it is set up so that the image will fit on the page when you print with
SendPS, Adobe’s public domain PostScript downloader.  SendPS may be used to download a file to the LaserWriter (or
any other PostScript printer), and it is principally useful for those who do not have Adobe Illustrator.  

Benchmark will not print on an Imagewriter, or any other non-PostScript printer.

You have the ability to specify the line weights that will be used on the charts.  Benchmark uses three lines:  the
border line is used to draw the rectangular border around the chart, the data line is used to draw the actual data being
represented by the chart (propeller efficiency, aircraft speed, etc.) and the grid line is used for everything else.  
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Hairlines and Your Sanity.  A hairline is specified by a line weight of 0.00.  On a
PostScript printer, a hairline is the thinnest line that the printer can draw.  On the 300 DPI
LaserWriter, a hairline gives a crisp, fine line of about 0.003” in width, while on a 1270 DPI
typesetter, a hairline is 0.0008” wide, and on a 2540 DPI typesetter, a hairline shrinks to only
0.0004”—which is barely visible to the human eye.  If you intend to print your charts on a
PostScript typesetter, be sure to specify the exact line width you want—a line of 0.25 points is
roughly equivalent to the LaserWriter’s hairline.  But on a LaserWriter nothing looks as crisp as a
hairline.  You would think that a line of, say, 0.01 points would look the same, but it will get
fatter than a hairline on curves.  

If you select LaserWriter, the standard LaserWriter Page Setup dialog box will appear:

Quit
Quits the program.
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Edit Menu
The Edit menu consists of commands which allow you to edit the data stored in Benchmark documents.  

Undo
Cut
Copy
Paste
Clear
These standard commands are used only for desk accessories.

Aircraft...
Brings up the Aircraft Data dialog box.  

Type the information required.  The low cruise weight is the lowest weight at which you would normally cruise
(empty weight + pilot weight + low fuel weight) and is used in the miles-per-gallon charts.  The payload is for Cafe
400 scoring.  

Pitot-Static Data...
Allows you to enter or edit data from pitot-static calibration flight test.  If you select Pitot-Static Data from the Edit
menu, the following dialog box will appear:

Enter the data required.  See “Standard Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the use of
this dialog box.  The Vias data required is for the indicated airspeed uncorrected for instrument error.  When the data is
analyzed (see Pitot-Static in the Analyze menu), the correction for instrument error is made automatically by
Benchmark.  

The Reset button allows you to ‘decalibrate’ the pitot-static system.  If you have entered data for the pitot-static
system, then selected Pitot-Static from the Analyze menu and curve-fitted a polynomial to the data, the Reset button
allows you to undo the curve-fitting while still retaining the pitot-static data.  
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Drag Polar Tests...
Allows you to enter or edit data from drag polar flight tests.  If you select Drag Polar Tests from the Edit menu, the
following dialog box will appear:

In this dialog box, you can select the drag polar tests to edit or delete.  As a shortcut, double-click a test to edit it.
You are limited to a maximum of 20 drag polar tests in the file.  

The Cancel button will cancel all changes made to any of the drag polar tests during the time when this dialog is open.

If you select New, or if you select a test to edit, the following dialog box will appear:

Type the information required.  

The aircraft weight is the weight at the start of the first run of the flight test.  You must calculate this by taking the
aircraft weight (including crew and equipment) prior to the flight and subtracting the weight of the fuel burned.  

During the calculations for Cdo and Oswald E, the indicated temperature at each run will be corrected for adiabatic
compression unless you turn this option off.  Turn the temperature correction off if you only noted the temperature at
one run.  See Appendix A for an explanation of adiabatic compression.  

When you click OK, the following dialog box will appear:

Type the information required in the data entry box of the Edit bar.  See “Standard Benchmark Data Edit Dialog Box”
on page 10-1 for an explanation of the use of this dialog box.  
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Engine...
Allows you to edit information about the engine.  

Type the information required.  

Min RPM is the minimum rpm you would normally consider for cruise because the propeller will hit the stops if you
run the engine slower than that.  This rpm is not critical but is used to preset the default that appears in the miles per
gallon chart dialog box.  

A number of dialogs, such as the speed calculator, do not allow you to enter an engine rpm below a certain figure.  Idle
RPM establishes this limit.  

Manifold Pressure Limit...
Allows you to enter or edit information about the engine’s limiting manifold pressure for continuous operation.

Power 2

MAP1 MAP2

Power 1

limiting manifold pressure
for continuous operation

Many engine sea level charts have a straight line called “limiting manifold pressure for continuous operation” as shown
above.  

Using the engine manufacturer’s engine chart, locate two points on the manifold pressure limit line, then choose
Manifold Pressure Limit from the Edit menu.  The following dialog box will appear:
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Type the numbers required.  Almost no error-checking is presently performed on the numbers: point 2 must be above
and to the right of point 1.  To have “no line”, i.e. no manifold pressure limit, zero all of the numbers.  

Power Data...
Brings up the following dialog box:

Type the information required in the data entry box of the Edit bar.  See “Standard Benchmark Data Edit Dialog Box”
on page 10-1 for an explanation of the use of this dialog box.  

The data that you type in the Power Data dialog comes from the engine manufacturer’s sea level performance chart, as
shown below:

Hpm
HP1

HP2

MAP1MAP2

For each diagonal line representing a constant rpm, carefully note the power (HP1 and HP2 in hp or kw) and manifold
pressure (MAP1 and MAP2 in inches of mercury or Bar) at two points.  Because Benchmark will be analyzing the
slope of the lines, it is desirable to use two points that are far apart—normally the lowest and highest readable points
for each rpm.  You also need to note the maximum power available (HPm) for each rpm.  For normally aspirated
engines, the curved line representing the maximum manifold pressure will curve to the left, but for turbocharged
engines, the line will curve to the right.  In each case, the line will originate at 29.92 inches of mercury (1.00 Bar) at 0
rpm.  In many cases, the engine manufacturer will not show the maximum power available at the lower rpm’s, so you
will have to extend the lines and curves to get the numbers required to model the engine power.  

Full Rich Fuel Data...
Best Power Fuel Data...
Best Economy Fuel Data...
Allows you to enter data for the fuel consumption of the engine.  If you select either of these commands from the Edit
menu, the following dialog box will appear:
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Enter the data required.  See “Standard Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the use of
this dialog box.  

If you are editing the best power or best economy fuel data, when you click OK, the following dialog box will appear:  

Most engines have a maximum power above which best power or best economy leaning is not permitted.  This
number is used by Benchmark in the engine power calculator, in the airplane speed calculator and in some of the
performance charts.  Enter the maximum power for best power or best economy leaning.  

Propeller...
Allows you to edit information about the propeller.  Choose Propeller from the Edit menu and the following dialog
box will appear:

Type the propeller manufacturer name, model number or name, and propeller diameter.  If the diameter is not in the
unit of measurement that you want, change it with the Inches/Centimeters popup.  

Dual rotation propellers are exceedingly rare and haven’t been used in piston-engine aircraft since just after WWII, but
Benchmark has the ability to calculate the efficiency of such a propeller.  

The blade activity factor (described more fully in Appendix A) is very much like the aspect ratio of a wing, but because
the tip of the propeller travels through air faster than the rest of the blade, some adjustment must be made for this.
The propeller manufacturer can supply this information.  

Blade Thickness applies only if the EHTS (equivalent helical tip speed—see Appendix A) goes over 1000 ft/second.
Unless you know that your propeller tip will be operating at those speeds, it is best to leave Blade Thickness set to
Average.

Airspeed Indicator...
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Altimeter...
Tachometer...
Manifold Pressure Gauge...
Allows you to edit information about the instruments.  If you select any of these commands from the Edit menu, the
following dialog box will appear:

Type the information required.  The Delete button is provided to delete the instrument from an aircraft file.  When you
click OK, the following dialog box will appear:

Type the information required.  See “Standard Benchmark Data Edit Dialog Box” on page 10-1 for an explanation of the
use of this dialog box.  This data will typically come from a calibration provided by an instrument shop.  
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Preferences...
Brings up the Preferences dialog box.

In this dialog box you select the way you want data displayed on the screen and in reports.  This does not change the
way Benchmark handles the data internally or nor does it affect Benchmark’s file format.  
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Analyze Menu
The Analyze menu contains commands to analyze engine, instrument, or aircraft performance data.

Pitot-Static...
Allows you to calibrate the pitot-static system.  This command is available only if an airplane file is open and if the
file contains pitot-static calibration data.  When you select Pitot-Static from the Analyze menu, the following dialog
box will appear:

The Order popup allows you to select the order of the polynomial.  When you select a different order, the curve for the
polynomial for the new order is plotted on the screen.  See Chapter 1 “Curves, Computers and Curve-Fitting” for a
complete explanation of the operation of this dialog box.  

Clicking on the OK button tells Benchmark to accept the currently selected order as your choice for the polynomial for
that curve.  

Drag Polar...
Allows you to analyze the drag polar of an airplane.  To use this command, the current document must be an airplane
file and it must have both engine and propeller installed as well as containing drag polar flight test data.  

❏ Choose Drag Polar from the Analyze menu.  The following dialog box will appear:

❏ Select a flight test.  The following dialog box will appear:
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Benchmark will solve for Cdo and Oswald E and will plot the data points on the screen in a straight line by plotting
Cd vs Cl2.  

For design purposes or if you want to engage in the practice of wishful thinking, you can type your own values for
Cdo and Oswald E.  Click on the Revert button to come back to reality.  

To print a chart of this, click on the Print Chart button.  To print a report, click on the Print Report button.  (The
report will only be readable if you select landscape printing.)

Use the Zoom In and Zoom Out buttons to get a better look at the data points.  

To see the numbers involved in the calculations, click on Data and the following dialog box will appear:

Benchmark will step through each run of the drag polar flight test and will show on the screen all of the pertinent data
and all of the numbers used in the calculations.   

Ram Recovery...
The ram recovery of an aircraft is the ability of the induction system to convert the air pressure entering the induction
system into a boost in manifold pressure.

To analyze the ram recovery of an aircraft with an engine installed,

❏ Choose Ram Recovery from the Analyze menu.  The following dialog box will appear:
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From data collected on a flight test, type the pressure altitude, indicated airspeed, engine rpm and the full throttle
manifold pressure observed.  The ram pressure is a function of the indicated airspeed, and this pressure is listed to the
right of the airspeed.  

Note.  All data required is indicated.  Benchmark will automatically correct for instrument error
and pitot-static error.  If you are not familiar with the process of calibrating the instruments and
pitot-static system, see Chapter 2 “Instrumentation” and Chapter 6 “The Pitot-Static System.”  

The manifold pressure must be in a range, starting with the still air maximum manifold pressure for the engine at the
rpm specified and increasing by the additional pressure available from the ram of the air entering the induction system.
Ram Recovery is expressed as a percent between 0 and 100.  

When you click OK, this data and the calculated ram recovery become part of the airplane data and will be stored in the
airplane file when you save.  

Engine Power...
To analyze the engine power,
❏ Choose Open from the File menu.
❏ Select Engine and select an engine file.

—or —
Select Airplane and select an airplane file that has an engine installed.

❏ Choose Engine Power from the Analyze menu.  

Benchmark does a curve-fit on the data, fitting curves for three curves, HPm, FHP and MPm.  It will come up with
polynomials from order 0 to 10 and then will wait for you to select which polynomial order best fits the situation.  As
long as a 2nd order polynomial is a better fit than one of order 0 or 1, Benchmark will always pre-select a 2nd-order
polynomial, since it is our experience that this is the best solution in almost every case.  

With each of the three curves, you will have an identical screen.  The Order popup allows you to select the order of the
polynomial.  When you select a different order, the curve for the polynomial for the new order is plotted on the screen.
See Chapter 1 “Curves, Computers and Curve-Fitting” for a complete explanation of the operation of this dialog box.  

Clicking on the OK button tells Benchmark to accept the currently selected order as your choice for the polynomial for
that curve.  
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With the engine now analyzed, you can now calculate the engine power at any condition.  See the Engine Power
calculator in the Calculate menu.  

Full Rich Fuel Consumption...
Best Power Fuel Consumption...
Best Economy Fuel Consumption...
Allows you to fit a multivariate polynomial to the fuel consumption data of an engine.  These commands are only
available if the required engine fuel consumption data is in the current engine or airplane file.  

If you select one of these commands from the Analyze menu, the following dialog box will appear:

This dialog box works like the normal Benchmark Curve-Fit dialog, except that in this case you are dealing with three-
dimensional (X-Y-Z) data.  To protect you from the confusion of which order applies to which variable, you are
allowed to select the polynomial order only for the curve shown.  Benchmark will pre-select an order of 2,2 and will
calculate that polynomial.  

To see the relationship between RPM and fuel useage, select the RPM button, and the display will change to:

Because of the nature of fuel flow curves, in most cases, a polynomial of the order of 2,2 is best.  If you select any
polynomial orders which have not yet been curve-fitted to the data, the Calc button will be activated.  When you click
on the Calc button, Benchmark will fit a polynomial to that data—but be warned, this process is very slow for high-
order polynomials.  

The process of fitting these multivariate polynomials is an excruciatingly complex series of calculations that really
does deserve that over-used description of ‘number-crunching’.  The data structures required are very large, and if you
select a high-order for one of the variables, you will notice that your choices for the other will be limited.  This
restriction is because of the limits of the size of the data structures.  
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Warning.  Each polynomial order set requires about 32K of memory, so if you attempt to
calculate all possible orders, this will require about 2.7MB of memory.  At this time, Benchmark
does not check for out-of-memory conditions, and will crash if you attempt to calculate too many
polynomial orders.  

To print a chart, click on the Print button.  (Doesn’t work yet.)  

When you select OK, the currently selected orders for the polynomial will be used to represent the fuel flow of the
engine.  

If you click on the Poly button, this will bring up the multivariate Polynomial dialog box, shown below:

This shows the polynomial coefficients of the polynomial being used, the RMS error and the maximum error.  

Airspeed Indicator...
Altimeter...
Tachometer...
Manifold Pressure Gauge...
Brings up the standard Benchmark Curve-Fit dialog box to fit a polynomial to the instrument data.  

See Chapter 1 “Curves, Computers and Curve-Fitting” for a complete explanation of the operation of this dialog box.  
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Font Menu
The Font menu allows you to change the font used in the printed charts.  It does not change the fonts used on the
screen.  Because of the way Benchmark prints, the Font menu is not affected by the fonts that you have in your
system.

Chart Menu
The Chart menu contains a number of commands to print specialized charts.

General Propeller Chart...
Prints two versions of the Boeing General Propeller chart.  When you choose this, the following dialog box appears:

Select either chart type.

Note. these charts are very complicated and take a substantial amount of time to create.  

Takeoff Propeller Chart...
Doesn’t do anything yet, and will just beep at you.  

Engine Sea-Level Altitude Chart...
Doesn’t do anything yet, and will just beep at you.  

Specific Fuel Consumption vs RPM...
This command is only available if the engine has full rich, best power or best economy fuel data that has been fitted
with polynomials—see “Entering Fuel Flow Data” and “Analyzing Engine Fuel Data” in Chapter 4 “The Engine.”  

If you choose this command, it brings up the following dialog box:

A chart is drawn for lines of constant power for Full Rich, Best Power or Best Economy.  If Best Power or Best
Economy is selected, the highest power that will be charted will be the maximum best-power power or maximum best-
economy power—see Best Power Fuel Data or Best Economy Fuel Data in the Edit menu.  The lines will be clipped at
the bottom for the line of limiting manifold pressure for continuous operation—see Manifold Pressure Limit in the
Edit menu.  If you want that limit line drawn on the chart, select Limit Line.  
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Min RPM and Max RPM determine the range of rpms that are charted.  Because most propellers hit the stops at low
rpm settings, it is not usually practical to operate at extremely low rpms.  There are limits placed on the range of
settings for the engine speeds:  Max RPM cannot be greater than 1.5 times the engine max rpms or must be at least
100 rpm more than Min RPM, and Min RPM cannot be less than engine idle speed and must be at least 100 rpm less
than Max RPM.  Because of this error-checking, Min RPM and Max RPM may be difficult to type.  If you encounter
problems, replace just one number at a time.  

Adiabatic Compression...
Doesn’t do anything yet, and will just beep at you.  

Miles Per Gallon...
This command is used to produce miles-per-gallon charts for flight manual pages.  

If you choose this command, it brings up the following dialog box:

Miles-per-gallon charts are typically produced for two weights, the highest and lowest weights at which the aircraft
would be flown under normal circumstances.  

The payload is used for Cafe 400 ratings.  

For most aircraft, the most efficient rpm is too low for practical operation because the propeller will hit the stops, so
you must specify the minimum rpm for the power schedule.  

The wind must be a positive number.  The wind direction must be in the range of 0 to 360 degrees—a headwind is 0
degrees, a tailwind is 180 degrees.  

Note.  In the extreme case that the crosswind component of the wind exceeds the speed of the
aircraft, Benchmark assumes that the aircraft would be flown at a 90° heading to (unsuccessfully)
compensate for the crosswind component, thus the speed of the aircraft will be the tailwind or
headwind alone.  In this case, the aircraft will be blown off course, thus the speed of the aircraft is
not an accurate on-course speed.  To indicate this condition, the speed and Cafe 400 scorings are
shown in italics in the data.  

When you have entered all of the data, click the Calc button to calculate the power schedule for the specificed
conditions.  The calculation process is relatively slow, but when the calculations are completed, the Plot Data button
will be activated.  This button toggles through three settings of Plot Data, Plot MPG and Plot Cafe 400.   

Click on the Print button while the data is displayed to print a report showing this data.  

You may change the payload, wind speed and wind direction at any time, but any change to the other settings will
require a recalculation of the data.  
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The Plot MPG setting produces the following display:

Change the wind speed and direction to see the change in speed and miles per gallon.  

Click on the Print button to print a chart of miles per gallon vs speed.  

The Plot Cafe 400 setting produces the following display:

In this display the Cafe 400 scores are plotted against the airplane speed.  Change the payload, wind speed and wind
direction to get a change in the chart, and use the Print button to print a chart.  
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Calculate Menu
The Calculate menu contains a number of specialized calculators.

Atmospherics Calculator...
The atmospherics calculator will calculate all of the normally-used pressure, temperature, density ratios for air, and will
also calculate the true airspeed of an aircraft based on those ratios.  

To use the atmospherics calculator:
❏ Choose Atmospherics from the Calculate menu.  The following dialog box will appear:  

Type numbers in the boxes for Pressure Altitude, Temperature and Vias.  Click on the radio buttons to select the units
of measurement.  Click on the checkbox to correct for adiabatic compression.  Benchmark calculates all of the values.  

Warning.  You can get into trouble with some very high altitudes and low temperatures.  Do not
attempt to type in a pressure altitude of over 30,000 feet or so, and watch out for conditions that
could result in a temperature of absolute zero.  The speed of sound in air is a function of
temperature only, and it is interesting to type very low temperature and watch the speed of sound
and density altitude.  (Near absolute zero, at which temperatures air would become a liquid—the
standard formula for the speed of sound in a gas would no longer apply.)  

Units Calculator...
The units calculator is provided to assist in the calibration of your instruments.  It shows the relationship between the
indications of an airspeed indicator, altimeter and manifold pressure gauge with a variety of pressure measurements.
The conversion is two-way; that is, you can type an indicated airspeed and get the equivalent pressure, or you can type
a pressure and get the equivalent indicated airspeed.  

Pitot-Static Calibration Calculator...
The pitot-static calibration calculator is provided to analyze pitot-static flight test data.  
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To use the pitot-static calibration calculator:
❏ Choose Pitot-Static Calibration from the Calculate menu.  The following dialog box will appear:

A typical pitot-static calibration flight test is made over a speed course of a known length.  The aircraft is flown at a
constant indicated airspeed and the elapsed time over the course is recorded.  To compensate for winds, two runs
through the course in opposite directions are normally done.  If two runs are used, the times are averaged to calculate
the ground speed.  

Below the indicated airspeed and pressure altitude are listed the corrections for instrument error, provided the
instruments have been calibrated and are represented by polynomials (see Airspeed Indicator and Altimeter in the
Analyze menu).  The correction to the outside air temperature (OAT) is for adiabatic compression, however unlike
other calculations in Benchmark this correction is based on ground speed and is computed directly without iteration, but
you have the option of turning this correction off.  The calibrated airspeed (Vcas) is computed from the ground speed
based on the pressure altitude and corrected outside air temperature.  

Use this calculator to reduce your pitot-static flight test data to a simple set of ViasUncorr and Vcas speeds, and enter
this data by choosing Pitot-Static from the Edit menu.  Note that the data required is for the indicated airspeed
uncorrected for instrument error.  When the data is analyzed (see Pitot-Static in the Analyze menu), the correction for
instrument error is made automatically by Benchmark.  

Propeller Efficiency Calculator...
The propeller efficiency calculator will calculate the efficiency of a propeller according to the Boeing General Propeller
Chart.  

To use the propeller efficiency calculator:
❏ Choose Propeller Efficiency from the Calculate menu.  The following dialog box will appear:
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If you have a propeller file open or have an airplane file open that has a propeller installed, the propeller specifications
will already be filled in.  Changing these does not change the specifications of the propeller file or propeller installed in
the airplane.  

Type in the boxes for speed, engine power, pressure altitude, temperature, propeller diameter, RPM, blade activity
factor, and number of blades.  

Dual rotation propellers are exceedingly rare and haven’t been used in piston-engine aircraft since just after WWII, but
Benchmark has the ability to calculate the efficiency of such a propeller.  

The Blade Activity Factor (see Appendix A) is very much like the aspect ratio of a wing.   

Blade Thickness applies only if the EHTS (equivalent helical tip speed—see Appendix A) goes over 1000 ft/second.
When the tips of the blades go supersonic, the propeller efficiency deteriorates rapidly, and thicker blades do so quicker
than thin blades.  

If ISO Standard is checked, the temperature for the ISO standard atmosphere is automatically calculated.  De-select ISO
Standard to type your own temperature.  

The propeller efficiency is plotted against for J/Cp^1/3 (abbreviated as J_Cp and J/CP in the dialog box) or Cpx
according to the setting on the Plot Eta Vs toggle button.  Click on the toggle button to change the setting.  When
propeller efficiency is plotted against Cpx, the display looks like this:

When the line is plotted as a gray line, this means that the values being plotted are outside the values represented on
the Boeing General Propeller Chart.  Similarly, any values that are not represented on the Boeing General Propeller
Chart are shown in italics in the bottom of the dialog box.  These out-of-range values should be treated with suspicion
and should not be taken seriously.  

The speed is also handled with a toggle button, click on the Vtas button to change the speed to Veas.  (Remember,
equivalent airspeed is indicated airspeed with no error—just think of it as “indicated”.)  

Engine Power Calculator...
The engine power calculator is the equivalent of a sea level/altitude power chart for an engine.  

To use the engine power calculator:
❏ If you have not already done so, open an engine file or an airplane file with an engine installed.  
❏ The engine data must be represented by polynomials.  
❏ Choose Engine Power from the Calculate menu.  The following dialog box will appear:
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Type values for manifold pressure, rpm, pressure altitude and temperature in the appropriate boxes.  If ISO Standard is
checked, the temperature for the ISO standard atmosphere will be automatically entered by Benchmark in the
temperature box, and you cannot change the temperature as long as this is checked.  If Full Throttle is checked, the
(still air) full throttle manifold pressure for that rpm/pressure altitude combination will be automatically entered by
Benchmark.  

Use the popup menus to change the units of measurement.

Airplane Speed Calculator...
The airplane speed calculator allows you to determine the speed of the aircraft at various altitudes, temperatures, power
settings, and weights.  To use this calculator, you must have an airplane file open, the airplane file must have an
engine and propeller installed, and you mush have analyzed a drag polar flight test to determine the Cdo and Oswald E
of the aircraft.

To use the airplane speed calculator:
❏ Choose Airplane Speed from the Calculate menu.  The following dialog box will appear:

Enter the settings you want and click on the Calc button to calculate the airplane speed.  The manifold pressure is
calculated in two different ways.  If Full Throttle is turned off, the manifold pressure is for still air; that is, the
induction system ram recovery is not calculated.  If Full Throttle is selected, the induction system ram recovery is
included, and the manifold pressure will be increased at each speed according to the ram available and the ram recovery
of the induction system.  

Because it is possible to assign a manifold pressure than is higher than possible at the altitude, you should use the full
throttle setting from the Percent Power popup after any change in altitude.  If you want to use a standard percent
power—55%, 65% or 75%—this is also available from the percent power popup.  

If the fuel flow characteristics of the engine are calibrated, the display will show the fuel flow and fuel economy at each
speed.  
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The THP/TkW and Vtas/Vias buttons at the bottom center are toggle buttons, and they allow you to switch the display
between thrust horsepower and thrust kilowatts, as well as between indicated airspeed and true airspeed.  

The minimum flying speed is not calculated, but will probably be added in the future.  The Best Climb text is editable.
The purpose of this is to allow you to type another climb speed and to get the rate of climb, but that has not yet been
implemented.  


